CONTENTS

Introduction .................................................................................................................. 3
Before You Start .......................................................................................................... 4
Buying A PC ................................................................................................................. 5

Using Your PC
The Basics .................................................................................................................... 8
Quick Tips .................................................................................................................... 12
Common Problems ..................................................................................................... 14
Change Display Settings And Text Size ..................................................................... 19
Update Your Hardware Devices ................................................................................ 23
Organise Your Files/Folders/Shortcuts ..................................................................... 25
Clean Out And Clean Up Files .................................................................................. 27
Preventing RSI ........................................................................................................... 29

Software
Useful Programs And Utilities ..................................................................................... 30
The Best Free Software ............................................................................................. 31
Create Documents In Microsoft Word ........................................................................ 32
Work With Pictures In Microsoft Paint ...................................................................... 35
Play Music And Video Files ....................................................................................... 38
Write CDs And DVDs ............................................................................................... 41
Compress Files ............................................................................................................ 44

Web And E-mail
Start Using Internet Explorer 7 .................................................................................. 46
Browse The Web With Firefox .................................................................................. 51
How To Use Search Engines .................................................................................... 55
Create And Backup Favorites ................................................................................... 57
Set Up A Hotmail E-mail Account ............................................................................ 59
Back Up E-mails In Outlook Express ........................................................................ 63
E-mail Attachments .................................................................................................... 65
Preventing Spam ......................................................................................................... 68
Set Up Instant Messaging .......................................................................................... 71
Get The Most From The Web .................................................................................... 75
Things To Do On The Web ......................................................................................... 77
Links To Useful Web Sites ......................................................................................... 78
Web Site Gallery .......................................................................................................... 81
Create A Blog .............................................................................................................. 83
Create Your Own Web Site ......................................................................................... 88
Making Web Sites - 30 Useful Tools ......................................................................... 91

Online Safety
5 Steps To Keep Your PC Safe Online ....................................................................... 92
Update Windows ......................................................................................................... 93
Install ZoneAlarm Firewall ......................................................................................... 95
Check For Viruses ....................................................................................................... 98
Remove Spyware ......................................................................................................... 100
How To Keep Kids Safe On The Web .......................................................................... 103

Appendixes
Jargon ............................................................................................................................ 105
Common Filetypes ....................................................................................................... 108
Keyboard Shortcuts ..................................................................................................... 109
Version History ........................................................................................................... 110
Introduction

“I’ve just bought my first PC and I want to use the Internet. Where’s the manual?!”

It’s amazing given the complexity of a modern computer and its Windows operating system, not to mention all the various programs you can buy or find on the Internet, that we often seem to be left to try to work things out by ourselves without any help.

Basic skills like learning to use a mouse and keyboard, finding our way around the Desktop and navigating Windows will have most first-timers regularly on the phone to their computer-savvy friends or relatives.

If you’ve used a PC for a while you may take it for granted that clicking the right button on your mouse brings up a menu, or that clicking a blue underlined word on a web page transports you to another web site or page. But these ideas are completely alien to those inexperienced with modern computers.

Even computer experts find there is so much to learn about using your PC and so many programs to try, that it can seem almost overwhelming. Even the simplest tasks like e-mailing a photo to a friend, or playing a music CD on your computer, can be very difficult if you have no idea where to start or what programs you need.

The Easy Computer Tips web site was set up to try to help by giving simple, easy-to-follow tips and information, taking you step-by-step through common tasks such as using particular programs, sending e-mails or organising files and folders.

Easy Computer Tips has also always had a strong focus on security; how to protect your PC (and yourself) when you connect to the Internet and surf the World Wide Web.

This guide, while not the mythical ‘missing manual’ to using your PC and the Web, should hopefully cover some of the more common questions you may have and help you achieve some of the practical things you need to do with your PC.

Paul Turner

Easy Computer Tips web site creator

contact@easycomputertips.com
Before You Start

The articles in this guide have been written to be as accurate and up-to-date as possible at time of writing, and if followed correctly should not result in any harm to your computer or the files on it.

However you should always make regular backups of your important files, and as an extra precaution you can set System Restore Points before making changes to system settings or updating programs. This allows you to go back to the point before you made the change, should anything go wrong.

To use System Restore, click the Start menu then Help and Support. Click undo changes to your computer with System Restore then Create a restore point. Click Next then give this point a description such as ‘before updating windows’ and click Create.

You will find that occasionally when following the steps in this guide, you need to restart your computer to finish installing a program or updating files. You should make sure you have saved any work you have open before continuing.

The tutorials in this guide were written for Windows XP but in most cases should work on other versions of Windows too. To find specific sections or phrases in this guide, use the Contents page or press the CTRL and F keys together to use the search facility. You can refer to the Jargon page for explanations of particular terms used.

Terms of Use

No unauthorized reproduction or distribution of this guide is permitted. This publication is available only from EasyComputerTips.com and may not be hosted on any other site. All trademarks are the property of their respective owners.
Copyright 2006 Paul Turner and Easy Computer Tips.com

Due to the ever-changing nature of the Web, some web site page links may change or be removed. If a link to a site no longer works, try typing the page title or web site name into a search engine to try to find its new location, or a similar alternative.

As programs and web sites continue to be updated all the time, it is possible that some instructions may no longer be accurate. If you believe there to be a mistake in this guide, have any suggestions or think there is anything that needs updating please send an e-mail to contact@easycomputertips.com

Please note that the use of materials in this guide is at your own risk. If you choose to use this guide you agree to accept responsibility for any action you take and any changes you make to your PC. No technical support can be provided. If you need further help with any of the programs or web sites in this guide, or have any other general computer queries, please use the message boards at www.easycomputertips.com/forum

www.easycomputertips.com
Buying A PC

First Steps

Before beginning your search for your new computer:

- Decide if you want a desktop PC or laptop (desktop PCs are more powerful but laptops are portable)
- Decide how much approximately you want to spend
- Decide what you will be using the PC for (you won't need a particularly powerful system if you're only going to browse the Web and send e-mails)
- Read some computer buying advice magazines such as What PC?, PC Advisor and Personal Computer World
- Talk to friends, relatives and colleagues about where they bought their PCs from and their experiences

Where To Buy From

High-street stores may seem the most obvious place for first-time PC buyers but although they do offer some advantages (such as being able to see and touch example PCs and get an idea of the size of the screen) they are not always good value and you may find yourself spending more than you need to.

Often the sales person will also try to sell you warranty packages. These may provide some peace of mind, including things like health checks and repairs, but if you look after your PC and keep your security software up-to-date, you will most likely never use the service and will have paid a lot of extra money for nothing.

You could try small local computer shops who can often put together a PC package to suit your exact needs, though you may find the price a lot higher than the standard packages offered by high-street stores. For first-time buyers a standard package often seems far simpler than trying to figure out the specific types of components you need.

Buying online is often the best option; though obviously you need to find some way of getting on the Internet (on a friend's PC or at your local library) and then begin the process of searching for online stores and comparing packages and prices. As with any large purchase you make, you will want to be cautious and have all the facts in front of you before you make a decision.

What to look for

Often when reading about PC packages you will be confronted with a huge list of specifications which will mean nothing to you if you don't have much knowledge of computer hardware. Some companies may try to confuse you with technical details, hoping that by mentioning large enough numbers you will think the PC is better than it really is.
Computer specifications change all the time, and your needs will determine what size or speed components are appropriate for you. The following is a general guide with some tips on what to look for:

- **Monitor** - it is important to check this is mentioned as although this may seem like an essential part of a PC system, some packages may not include one. TFT (Flat Panel) monitors are common nowadays because of how thin they are compared to the old bulky CRT monitors. When buying a monitor you want the highest resolution, which will give a more detailed and sharper picture. A resolution of 1280x1024 should be fine for most users. Response time is also important – the lower the number, the better.

- **Keyboard / Mouse** - all desktop PCs should include these and there is often little difference between the various models. One thing to note is that some have more than just the left and right buttons on the Mouse - they often also include a Wheel in the center which can be a useful addition. Nowadays you can also get wireless keyboards and mice. If you want to use a mouse with your laptop you may need to buy it separately, as many laptops use a touchpad system instead of a mouse.

- **Floppy Disk Drive** – once a standard for all PCs, these are now increasingly rare so decide if you need one. Floppy disks have very small storage space and are not really big enough for most files you will work with. CDs, DVDs and data devices are more suitable for modern data storage and backup purposes.

- **Tower Unit** - the shell of the desktop PC contains all the components which make your system work including the processor, memory and Hard Disk. You should check how many USB ports are included, as you will need one for each peripheral you connect such as scanners and printers.

- **Processor** - the heart of your PC, this is the engine that powers your computer and processes all the instructions it is given, therefore you want it to be as fast as possible. The higher the processor speed (in Ghz) the faster your PC should be. Examples are Intel Pentium or Celeron, and AMD Athlon or Sempron.

- **RAM** - the temporary memory the computer uses to do its calculations. The more RAM you have, the faster and more efficient your programs will run. Look for at least 512 MB of RAM.

- **Hard Disk** - where all your programs and data are stored. As usual, more is better. At least 60GB or more will be needed to store lots of music, games or movie files. You may see packages with huge amounts of hard disk space - this is because it is a fairly cheap way of making a package sound better, when really most users will never need that much disk space.

- **Graphics Card** - handles video and display calculations. A more powerful card means better quality video graphics and smooth-running games. The most popular cards are the NVidia GeForce and ATI Radeon series. Another thing to note is that the graphics card also has its own RAM memory, and again the more the better.
• **Sound Card** - most PCs should include decent enough sound for playing music or video, but you can opt for better quality sound cards such as the Creative Audigy series which will improve sound quality and performance in movies and demanding games.

• **Speakers** - 2 normal desktop speakers should be fine for most users, but games players may want to invest in larger set-ups such as 5.1 (5 small Satellite speakers and 1 large Sub-Woofer to handle the bass sounds).

• **CD/DVD-ROM Drive** - plays CDs/DVDs including data discs, music CDs and film DVDs. The higher the speed, the faster files will be loaded from disc though it will depend on the maximum speed permitted by the disc itself. ‘16x’, for example, means it can transfer data from the disc at 16 times the normal playing speed.

• **CD/DVD R/RW Writer/Burner Drive** - as with CD/DVD-ROM Drives but also able to write or ‘burn’ discs as well as read them. This way you can create your own data, music or video discs, especially useful for backing up large amounts of data. There are two main categories of writeable discs: Recordable discs such as CD-R or DVD-R or DVD+R are discs that can only be written once and Re-Writeable discs such as CD-RW or DVD-RW or DVD+RW can be written over many times like a blank video cassette.

• **Internet Access** – many packages come with free Internet trials, but you can choose a different provider if you find a better deal. To access the Internet from home you will need to connect your PC to your phone line. There should be instructions with your PC how to do this. There are many different Internet packages available, and with some you will need to buy additional equipment. To learn more, contact an ISP (Internet Service Provider) or visit their web site.

• **Wireless Internet** - PCs and especially laptops may come with built-in wireless support, to allow you to connect to any wireless Internet networks within range. If not, wireless adapters can be bought separately.

You can usually replace and upgrade your PC components in the future if you decide you need more memory or a faster graphics card, for example.

**Web Sites Selling PCs**

The following is a list of a few of the web sites you can buy PCs from:

- [www.alienware.com](http://www.alienware.com)
- [www.dabs.com](http://www.dabs.com)
- [www.dell.com](http://www.dell.com)
- [www.evesham.com](http://www.evesham.com)
- [www.fujitsu-siemens.com](http://www.fujitsu-siemens.com)
- [www.meshcomputers.com](http://www.meshcomputers.com)
- [www.packardbell.com](http://www.packardbell.com)
The Basics

The Mouse

Most PC users will spend more time using one particular device to interact with their computer than any other, even the Keyboard. The Mouse is primarily used to move the pointer arrow around the screen and to select and activate options.

Beginner computer users often find that using a mouse for the first time is a little tricky – especially when it comes to what to do when the mouse reaches the edge of the mat, but your on-screen pointer still has further to go.

The idea is that when the mouse is not on the mat, it isn’t sending any instructions to the pointer. So to move the pointer all the way across the screen you should slide the mouse along to the edge of the mat, then lift the mouse up off the mat by a few centimetres, place the mouse back down and repeat the same sliding motion again until your pointer reaches the edge of the screen.

Practice moving your pointer in ‘circles’ around the screen to get a feel for the mouse. Begin with small gentle circular movements and then get faster and wider, drawing a larger circle on the mat and on-screen. You should find that the faster you move the mouse the more distance you cover on-screen.

The mouse buttons are used to interact with whatever is on the screen where the pointer is located. The left mouse button is the one you will use most often. Clicking this tells the PC to select an item and is called ‘left-clicking’. To activate an item and use it, you will often need to click the button twice or ‘double-click’.

Left-clicking on text in a document will place a flashing cursor at that point, which allows you to begin typing there. If you click and hold the left button and move the mouse, this has the effect of ‘dragging’ an object about the screen until you release the button.

The right mouse button is often used to bring up a small menu window that gives options specific to the item. To use a particular option you just left-click it. So for example, ‘right-clicking’ on a song would give you options to play the song in various music programs. Move your pointer to the Play option and left-click to start playing.

Common right-click menu options for an item include: Open (activate – same as if you double-click), Cut (remove to be placed elsewhere), Copy (make a copy), Create Shortcut (create an icon elsewhere to give quick access), Delete (remove permanently), Rename (give a new name), and Properties (find out information).

You may have a third smaller button in the center of your mouse that can be rolled forwards and backwards. This mouse-wheel can be used to move up and down through documents.
The Keyboard

**Keyboards** can come in a number of different layouts. QWERTY keyboards are so-called because the top line of letters, underneath the number line, begins with those six letters.

There are a number of other useful keys too. The *Enter* key confirms a selection, and pressing the *Shift* and *Caps Lock* keys activates uppercase letters when you type or the special characters above the number keys.

There are several function keys beginning with *F1*, *F2* and these are used to access different options in different programs. Other keys such as *Home*, *End* and *Page Up* and *Page Down* allow you to quickly move about within a document.

The arrow keys move the text typing cursor up, down, left or right.

You may have a number keypad too. This acts as an alternative to the number keys above the main letter keys. Pressing the *Num Lock* button will switch between using the keypad as numbers keys, or arrow keys.

There are certain key combinations that can be used to perform particular tasks. See **Keyboard Shortcuts** for more information.

The Desktop

The **Desktop** is the main background on your screen when you are working on your PC. It consists of a background picture or ‘wallpaper’, any program shortcuts you have created, and the **Taskbar**.

The Taskbar runs along the bottom of the screen (or the side, or top - you can click and drag it wherever you want to place it) and shows the date and time as well as giving you access to the **Start menu**. You can also put program shortcuts on the taskbar so that one click will activate a particular program.

Left-clicking on the **Start menu** brings up the **All Programs** list of shortcuts to programs you have on your computer. These are often arranged in ‘folders’, so that you can find all the programs made by one company under a folder in their name.

By holding the mouse pointer over a folder you will see a new list appear of whatever programs are within that folder. Some programs will have several related entries – so you might see a README (a document that has instructions for using the program), or an option to **Uninstall** (remove the program from your PC).

You can access your Desktop settings by right-clicking anywhere on the background wallpaper and then clicking on *Properties*. 
Windows

The operating system that runs all your programs and allows you to easily interact with your PC is called **Windows** for a reason. It allows you to work with several different items and programs at once, all in their own ‘window’. A window is like a smaller screen contained within a box on your main screen.

When you are working with a window it is brought to the ‘front’ of the screen, overlapping the Desktop and any other items behind it, so that you can focus on whatever is in the window.

In this way, you can have several windows open at the same time containing different programs that can be opened, closed, and re-arranged across the screen. This means you can do multiple tasks at the same time, such as playing your favourite music while writing an e-mail for example.

Files and Folders

Every item on your PC, whether it is a document, picture, song, game or whatever, is a **file** that is stored on your computer’s Hard Disk. A file can only be activated by programs that understand and are able to use it.

For example, you cannot use a music program to open a letter document. Each program on your computer understands what type of file it can or cannot use by the fact that every file has a **filetype** given to it.

This takes the form of a few extra letters or numbers added on to its name after a full stop. So for example, ‘myletter.doc’ is a file named ‘myletter’ with a filetype ‘.doc’, meaning it will require a program that understands doc (document) files, such as **Microsoft Word**.

There are many different filetypes. Read [Common Filetypes](#) for more information.

Any one single program or application can actually consist of many different files, all working together to achieve the same task.

This means modern computers can have millions of files spread across different locations. **Folders** help organize these files so that for each particular program there can be one folder that contains just the files it needs.

Some folders will contain other folders inside them called ‘sub-folders’. For example, to organise your holiday pictures together you might have a folder called ‘Holidays 2006’ and then other sub-folders within that for each particular holiday destination.

You can create your own folders. You can also create shortcuts to make it easier to find particular files. Read [Organise Your Files/Folders/Shortcuts](#) to learn more.

You can take a look at an example of a folder now. On your Desktop you should see a shortcut icon called **My Documents**. Double-clicking this will open a new window showing the contents of the **My Documents** folder.
My Documents

My Documents is a folder on your computer that is automatically created by Windows, so that you can store all your own files in one place separate from all the other program and system files Windows uses, making them easier to find.

Double-click the My Documents shortcut on the Desktop and you will see a list of folders, within which are your files. To see what is inside a folder, double-click on it and the current window will change to show the contents.

Windows and other programs automatically create folders to help you store certain types of files – so you may see folders such as My Music, My Pictures and My Videos. However, you do not have to use these – you can store any of your files anywhere you want to. You don’t even have to use My Documents.

My Computer

Close the current window by clicking the X button in the top-right. On your Desktop, double-click the My Computer shortcut and you will see a list of locations where files are stored on your PC.

If you double-click the Local Disk (your Hard Disk, usually C:) you can see all the folders of files that are stored on your Hard Disk. The Program Files and Windows folders here are especially important, and should not be changed as they contain the files necessary for programs and Windows to run.

All files take up disk space and your computer only has so much room to store them all. If you want to see how much of your Hard Disk you have used up so far, and how much space you have left, double-click My Computer again and this time, instead of double-clicking the Local Disk, right-click and select Properties.

If you right-click the My Computer icon on the Desktop rather than double-clicking it, and then click on Properties, you can see detailed information about your PC including your hardware devices and performance settings.

The Control Panel

The Control Panel is a collection of all the important options you will need when you want to change settings on your computer. You can find control icons for display, sound, Internet, hardware, programs, security and system settings. To access the Control Panel, click the Start menu and then click Control Panel.

Changing settings in the Control Panel can make big changes to your PC’s setup. For example, the Appearance and Themes or Display options in the Control Panel can affect the quality of your screen and the size of text. Read Change Display Settings And Text Size for more information.

Click on your Start Menu and then Help and Support for more help with using your PC and particular Windows features.
Quick Tips

Quick web address

Type the name of a web site such as 'myspace' into your browser's address bar and press \textit{CTRL}+\textit{Enter} to automatically add \textit{http://www} and \textit{.com} and be taken to the site.

Save a web page picture

To copy a picture from a web site on to your computer, right-click the image and select \textit{Save Image As} or \textit{Save Picture As}.

Move between web links

Use \textit{Tab} and \textit{Shift}+\textit{Tab} to move between links on a web page and press \textit{Enter} to follow the selected link.

Change the clock

Double click on the clock on the Taskbar to change the time and date shown.

Save web video clips

To download video clips embedded on a web page, in \textbf{Firefox} right-click the page and select \textit{View Page Info} then click the \textit{Media} tab. Select the video file and click \textit{Save As}.

Check hard disk space

Double click on the \textit{My Computer} icon on your desktop and right-click on your hard disk (usually drive C). Click \textit{Properties} to see the amount of disk space left on your computer.

Create a web shortcut

Right-click on a web page in your browser and select \textit{Create Shortcut} to place a shortcut link on your Desktop.

Change how you view file lists

You can change how your files are shown in a folder by clicking on \textit{View} then choosing between \textit{Thumbnails}, \textit{Tiles}, \textit{Icons}, \textit{List} or \textit{Details}.

Create Taskbar shortcuts

Drag a file, folder or shortcut on to the Taskbar for quick access to programs, files or web sites.
Change Desktop background

Right click on your Desktop and select Properties. Click on the Desktop tab, pick a new Background and click Apply to change your wallpaper.

Take a screen snapshot

Press Print Screen to take a snapshot of the whole screen or ALT and Print Screen for just the current window, then paste it into an image editor such as Paint to save it as a picture file.

Make web pages easier to read

To make text on web pages easier to read, click on View (or Page in Internet Explorer 7) then Text Size and choose a larger size.

Use BCC

To send an e-mail to several people at once without showing all their addresses at the top of the e-mail, use the BCC (Blind Carbon Copy) box in your e-mail client.

Burn CDs/DVDs safely

When writing a CD or DVD leave your PC alone, as using other programs at the same time could interfere with the burning process.

Alter music speed

In Windows Media Player, click the View menu then Enhancements and Play Speed Settings. Move the slider to speed up or slow down a song.

Picture slideshow

Open a folder of pictures and from the Explorer menu on the left click Picture Tasks and then View as a slideshow.

Change volume

Change your speaker volume by clicking on the Start menu and Control Panel, then click Sounds and Audio Devices to change your sound settings.

Open Zip files

In Windows XP, open compressed Zip files by double-clicking them. Click and drag the files inside out to another folder or the Desktop to extract them.
Common Problems

A list of common computer problems and solutions. Categories include Virus and Spyware, Browsing the Web, E-mail, Windows and Programs.

Virus and Spyware

How to check if I have a virus or spyware?

There is a free online scanner available to check if you have any virus or spyware on your PC: Trend Micro HouseCall
For more information about virus and spyware detection and removal read these tips: Check For Viruses and Remove Spyware

What can I do to keep my PC safe online?

Keep Windows updated regularly by visiting the Microsoft web site. Use a firewall and anti-virus and spyware removal programs, and use Firefox instead of Internet Explorer. You can find more information in 5 Steps To Keep Your PC Safe Online

Browsing the Web

How can I check if a web site is safe to visit?

Internet Explorer 7 and Firefox 2 feature built-in tools to warn you about malicious sites. Read Start Using Internet Explorer 7 and Browse The Web With Firefox for more information.

What can I do to keep my child safe on the Web?

There are several steps you can take to keep children safe when using the Internet. Read How To Keep Kids Safe On The Web for more information.

Why has my browser homepage changed?

If when you start your browser it loads a different web site instead of your normal homepage, it is possible a malicious program has hijacked your browser and set a different homepage.

To change it back, click on the Tools menu then Internet Options. On the General tab, under the section Home page you should see an Address box. Type in the address of the site you want (or click Use Current for the site you are currently viewing) and click OK.

If you find your homepage keeps changing on its own, you will need to use an anti-spyware program. Read Remove Spyware for more information.
My browser window opens too small

Your web browser remembers the size it was last used at, so if you or a web site have changed the size it will appear like this the next time you start your browser.

To set the correct size, start your browser and hold your mouse over the corner of the window until you see the resize arrows, then click and drag to change the size, then close the browser. When you next start your browser the window should open at the same size.

Some Web sites do not display correctly

If particular web sites are not displaying correctly - with errors, missing buttons or images, links that do not work, incorrect layouts - this may be due to your browser security settings, which can block parts of a web site it decides are potentially unsafe (though there may be nothing wrong with them, it is just being cautious).

To change security settings in Internet Explorer click on the Tools menu then Internet Options, but be careful as changing to a low security setting might let unsafe content through to the PC.

There may just be a problem with the web site itself, in which case try again later.

Web page text is too small

You can increase the size of text on a web page by clicking on the View menu (Page in Internet Explorer 7) at the top of the browser window, then select Text Size and choose a larger size. This should work with most text on web pages though not all.

My browser address bar has disappeared

Click on View from the menu at the top (or Tools in Internet Explorer 7) then Toolbars. Click to tick the Address Bar option and it should reappear.

How can I get rid of pop-up adverts?

To stop adverts opening in new windows you need a pop-up blocker. Both Internet Explorer and Firefox have built-in pop-up blockers. In IE go to Tools > Pop-up blocker to turn it on or change your settings.

How can I tell if a web site is secure before buying?

To know whether a site is secure before you give your credit card details, look at the address bar and make sure the web address begins with https://

There should also be a padlock symbol on the address bar (or at the bottom of the page in older versions of Internet Explorer) to indicate the site is secure.
How do I print only certain text or images from a web page

Rather than printing out a whole web page, you can select the particular text you want and copy it to a Word document, and then print it out.

Start Microsoft Word and minimise it by clicking on the minimise button at the top-right of the window. Now open your web browser window and click and drag your mouse pointer across the text you want to highlight it. Right-click and Copy. Return to Word by maximising it from the taskbar, right-click and Paste. You can repeat this process as many times as you like to get all the text you want into one Word document.

You can copy and paste most images in the same way by right-clicking on the image and clicking Copy. Alternatively you can choose Save As to save a picture to somewhere on your PC, for example the Desktop or My Documents. Then in Word, click Insert then Picture From File. Click to select the picture you have saved then click Insert.

You can then Print your document. By using Word you also have the ability to rearrange, edit and resize text and images before printing.

Web page won't print properly

Sometimes when you try to print a web page it prints incorrectly, for example the right edge of the page may be missing. Look for a Printer-friendly page option, or try printing in Landscape mode in File > Page Setup.

You can also try reducing the size of the default right-hand margin in Page Setup. Alternatively copy and paste the areas of the page you want into Word and then print from there.

In Internet Explorer 7 there are improved printing features. Text can be automatically shrunk for printing so all web page content fits on the printed page.

Web page not found 404 error

This common error message indicates that the address or link you have used is incorrect, or it points to a page that no longer exists or has been moved.

Why does online music or video keep cutting out?

Music and audio on the Web often loads some of the content and starts playing while the rest of the file is still being downloaded. This means you don't have to wait too long to hear/see anything, but sometimes you may catch up with it and it has to stop until it has downloaded the rest of the data.

If you find this annoying, you could press pause and then wait for the loading bar to reach full before playing the file. Also if you are using Windows Media Player you can go to Tools > Options > Performance and increase the buffer size.
E-mail

How can I stop getting spam?

You cannot completely remove the possibility of receiving spam but there are steps you can take to help reduce the number of unwanted e-mails you receive. Read Preventing Spam for more information.

I can't open my e-mail attachments

Outlook Express can block some attachments if it thinks they might be viruses and they will appear greyed out. If you are sure you want to allow these attachments, go to Tools > Options > Security and un-tick the box 'Do not allow attachments to be saved or opened that could potentially be a virus'. Click OK.

If you can access a particular attachment but can't open the file on your PC, you may not have the necessary program installed to run that type of file. You need to ask the person who sent you the attachment what program they used to create it, or ask them to save it in a more common filetype if they can.

Alternatively use a search engine to try to find the necessary program depending on the filetype extension, for example an attachment filename that ends in .ppt will require Powerpoint. See also Common Filetypes.

My photographs are too big to send as e-mail attachments

Read E-mail Attachments to find out about reducing the file size of images to send as e-mail attachments.

Windows

My PC has stopped responding! What do I do?

If a program or window on your PC seems to have frozen up and you cannot close it by clicking the X (Close) button in the top-right corner, hold down the CTRL and ALT keys together and tap DELETE once.

In Windows Task Manager click on Applications which shows all the programs that are currently running. You can usually tell which program has frozen or crashed as its Status will appear as Not responding. Click to highlight that program on the list then click on End Task. The PC will now attempt to close it. If it is successful you can then close Task Manager and the PC should be able to carry on as normal.

If Task Manager does not appear, try holding down CTRL, ALT and DELETE and keeping all three keys held. This will restart your PC, which will often fix the problem. If these keys don't work, you will have to press and hold the power switch or turn the plug off. Turn the PC back on. Your PC should be alright but always try to avoid switching off without shutting down properly first.
I'm running out of disk space. How do I clear out unnecessary files?

Read Clean Out And Clean Up Files to learn about removing unnecessary files.

I have deleted a file by mistake! What can I do?

First check the Recycle Bin on your Desktop to see if it is in there. Deleted documents go there first, so if you find it there and want to put it back where it was, right-click it and select Restore.

Once items are deleted from the Recycle Bin you will need special software to retrieve them, such as Recover My Files.

I can't find a particular file or folder but I know it's on my PC somewhere!

Click on the Start menu and Search all files and folders. Type in the name of the missing file or folder and Windows will try to find it.

I can't see any system files or folders! Where are they?

Important system files and folders are usually hidden to prevent accidental deletion. They still exist but will not be visible.

To see them, open any folder and click on Tools then Folder Options. Click on the View tab and under the Advanced Settings list tick Show hidden files and folders. Also un-tick Hide protected operating system files. Now click OK.

Programs

How do I get rid of a program I don't need anymore?

To remove a program you need to uninstall it from your PC. Click on the Start menu then Control Panel. Click on Add/Remove programs, select the program from the list and click Remove.

Alternatively, go to your Start menu and in your programs list, find the entry for the particular program and click on the link to Uninstall the program.

File won't open

Sometimes when you double-click a file, nothing happens or the program that is usually used to open that type of file can't run it. Instead, right-click the file and use Open With.. to choose a different program to try to open it with. See also Common Filetypes.
Change Display Settings And Text Size

This article explains how to change your display settings to make text easier to read, increase the quality of graphics or choose a new appearance for your desktop.

Introduction

If you find text too small to read comfortably, or get headaches from looking at your screen, you might not realize you can make simple changes to your Display settings to make things better.

You can also change your desktop background picture, add a screen saver, improve video and games performance, or even get a whole new look for Windows.

This guide shows you how to change settings such as resolution and refresh rate to improve your screen display. When altering any settings, remember to click Apply or OK to save your changes.

Alter your screen display settings

You can access your Display settings by right-clicking anywhere on the Desktop and then choosing Properties. You can also access these settings through the Appearance and Themes and Display icon in Control Panel.

You will now see the Display Properties window which has display settings arranged under five tabs - Themes, Desktop, Screen Saver, Appearance and Settings.
Themes

Under this tab you can choose a theme which will apply to all your Windows screen colours, icons and sounds.

Desktop

Click on this tab to choose a different desktop background image. Choose an image from the samples available, or Browse to locate another image on your computer.

You can also set the background at any time by right-clicking on an image in your web browser or in a folder, and selecting Set as Desktop Background.

Click Customize Desktop to open the Desktop Items window, which includes two tabs - General and Web.

On the General tab you can choose which shortcut icons to show on the desktop or use Desktop cleanup to remove items that haven't been used in a while.

The Web tab allows you to display a web page directly onto the desktop.

Screen Saver

Here you can choose a Screen saver which will appear when your computer has been idle for a specified amount of time.

These can help protect the image quality of the monitor if you regularly leave your PC for more than a few minutes. You can choose not to use a Screen saver if you find it annoying or if it interferes with other tasks.

If you select a Screen saver from the list you can see a preview and also set the idle time before it will start, and whether a password is required to use the PC when returning to the desktop - useful for privacy in an office or public environment.

You can also change the Power settings of your monitor here, including how long it should stay switched on if the PC is idle.

Appearance

Under this section you can change the style and colours of your Windows and buttons, and the size of your fonts.

Click on the drop-down arrow buttons to choose different settings, which will be previewed for you in the picture above the options.

The Font size option is useful if you find text too small to read - set to Large Fonts or Extra Large Fonts as required. Click on Advanced to choose size and colour settings for individual screen items such as windows, borders, icons and menus.
Settings

Under this tab you can set screen resolution and colour quality.

Resolution determines the number of pixels across and down the screen that are used to make up the display. The higher the setting, the more detailed your display.

A higher resolution gives you a larger screen area to work with, but if you find text and icons are now too small you may need to increase font size and use larger icons to compensate.

You can only go up to the highest resolution that your monitor can support. Experiment to find a resolution you are comfortable with.

The Color quality option should be set at Highest (32 bit) for the best quality display. Click on Troubleshoot to get Windows Help topics if you have display problems.

Clicking on the Advanced button will bring up a new window with several new tabs - General, Adapter, Monitor, Troubleshoot, Color Management, and a tab for your particular graphics card.
General

If you have set a high resolution, increasing the DPI (dots per inch) setting here will make all screen items including text appear larger.

Adapter

Information about your graphics card. Click Properties for details of the driver software you are currently using.

Monitor

Here you can increase the Screen refresh rate. Some people are more sensitive than others to the speed at which the monitor screen is updated, and may find low refresh rates can strain their eyes and cause headaches.

Tick Hide modes that this monitor cannot display, then choose the highest refresh rate using the drop-down menu. Note that LCD monitors do not have this problem, and users of these should instead set the refresh rate to the setting recommended in your monitor manual, usually 60 Hertz.

Troubleshoot

You can change your graphics card performance using the Hardware acceleration slider. Usually you will want to leave this set at Full, but if you are experiencing graphics problems you can try moving the slider down a notch.

Color Management

Allows designers and photographers to create colour profiles to improve quality for different screens and printers.

The final tab contains settings for your particular graphics card.

The advanced settings in this tab can be used for tweaking performance especially when running demanding 3D games. Useful guides for tweaking specific graphics card settings can be found at Tweak Guides system guides.

You should also visit the web site of your graphics card manufacturer such as ATI or Nvidia, and download their latest driver software. Often, these driver updates contain fixes for graphics problems with certain programs or display configurations.

Alter your web browser Text Size

If you find text on web sites too small to read, you can change your settings through your browser menu by clicking on View (Page in Internet Explorer 7) then Text Size, and increase the size of the text. Depending on the way the web site was created, this may not work with all text on all pages. Sometimes web site text is programmed to stay at an exact size in order to keep it within a strict design layout.
Update Your Hardware Devices

This article explains how to download and install new software drivers to solve problems with your hardware and improve performance.

What Are Drivers?

In order to make your hardware (such as graphics and sound cards, scanners, printers) work properly, Windows relies on special programs called Drivers.

These tell Windows how to use your hardware, and these drivers will either be installed on your PC along with Windows, pre-installed by the company you bought the PC from, or on the disks or CDs that came with your hardware. They can often also be downloaded from the website of the company who made the particular device, and this is also where you will be able to find any newer versions of the drivers.

Making sure you have the latest drivers for your hardware is the first step you should take if you encounter problems such as unstable Internet connection, graphics problems, crackling/popping sound, slow performance or crashes when running programs.

Identifying Current Drivers

First you need to identify the Driver version you currently have on your computer. Click on Start, go to Control Panel and then double-click System. Click on the Hardware tab and look for the button called Device Manager. You should now see a list of the hardware on your PC, divided into categories of hardware types.

By the side of each category you should see a small symbol. If the symbol looks like it means the section can be 'expanded' (i.e. opened up to show items within this section) by left-clicking once on the symbol. When the symbol looks like you should be able to see a list of items under this section.

Look for the piece of hardware you want to update. Here are some examples of the categories you might be able to find your hardware devices under:

- **Modem** (e.g. SpeedTouch USB) – under Network adapters
- **Graphics card** (e.g. Nvidia Geforce) – under Display adapters
- **Sound card** (e.g. SoundBlaster) – under Sound, video and game controllers

Once you have located the piece of hardware you want to update, right-click the item and select Properties, then click on the Driver tab on the new window and you should now see some details about the driver currently being used for this hardware. Make a note of the Driver Date and the Driver Version, then close this window. Close the Device Manager window when you have made notes of all the devices you want to update.
Downloading New Drivers

To find the latest version of the driver for your hardware, you need to visit the manufacturer's web site. If you bought the device separately from your PC, finding the address of the manufacturer's web site may be as simple as looking in the manual or documentation that came with your hardware.

You can also try using a search engine and typing in the name of the company, or better still the name of your device. So for example, if you want to find the driver for your NVIDIA GeForce graphics card, type nvidia geforce driver into a search engine and try to find the correct web site - in this case www.nvidia.com.

Once you have found the Driver download page, you will need to find and download the latest driver for your particular piece of hardware. You can then make a comparison between the drivers listed and the Driver Date and Driver Version you made a note of earlier, to see whether you need to update.

The process will vary from site to site, but before you download the driver file you may be asked to select things like your operating system (e.g. Windows XP), your language (e.g. English) and the name of your particular device.

Using NVIDIA's site as an example, you are presented with three tables from which you must select the type of download (e.g. Graphics driver), the make of device (e.g. GeForce) and the operating system you are running (e.g. Windows XP). When you have made your selections, clicking on the Go button will take you to a page where you can download the latest driver by clicking on one of the download site links.

When downloading a driver you may be asked to agree to some terms and conditions first, click Accept and then a File Download window will open, click Save to put the driver installation file somewhere on your computer.

Installing New Drivers

Locate the driver file you have downloaded, which will usually be of the file type .exe or .zip, and follow these instructions:

- .EXE If it is an .exe file you can just double-click it to begin installation.
- .ZIP If it is a .zip file then this is a compressed file and you will need to unzip it first using a program such as WinZip. Extract the file inside the zip to somewhere on your computer, then double-click it to open it.

Driver installation procedures may vary, but you may be asked to choose your Language, select certain options or agree to terms. After installation is complete, you may have to restart your PC, in which case you should make sure to save any work in other windows first. After restarting you can check the Driver Date and Driver Version number have changed to the latest version by going into Device Manager as before.

You can check the help and support pages, Frequently Asked Questions (FAQs) or messageboards on the manufacturer’s web site if you have any problems.
Organise Your Files/Folders/Shortcuts

This article explains how to work with files, folders and shortcuts in Windows.

Benefits Of Organising Files and Folders

Each program you install creates its own folder on your Hard Drive where it keeps most of its files. This helps your PC to find the right files to use when running a program.

Keeping files organised in folders can also help you when you are working with your PC. You can use folders to sort your files into separate categories, and place shortcuts to your favourite programs on the Desktop for easy access.

Knowing how to create, move, copy and delete folders and shortcuts can help you arrange your files much more efficiently, and allow you to easily find the files you are looking for.

Creating Folders

Double-click the My Documents icon on your Desktop. This is where your files and folders are stored.

To create your own folder, click File in the menu at the top of the window and select New then Folder. You could instead right-click on any of the white space in the window and select New then Folder to quickly achieve the same result.

You should see a folder entitled 'New Folder' appear. It should already be highlighted in which case you can start typing the name you want to give the folder, then press the Enter key to confirm. You can call the folder whatever you want, for the purpose of this example name it Test Folder.

If you ever need to change the name of a file or folder, just right-click it and select Rename.

Putting Files Into Your Test Folder

Double-click on your new folder to see its contents (at the moment it will be empty).

To copy some files into the Test Folder, open a new window by double-clicking the My Documents icon again and navigating to the files you want to copy. For this example, just find some music or picture files you have.

To move these files into the new folder, you can just click and drag each one from the new window to the Test Folder in the old window. If you hold down CTRL as you click and drag, the files will be copied rather than permanently moved. To move a file back, just click and drag it back to its original folder.
You can select more than one file at once by holding \textit{CTRL} and clicking once on each file you want. Then if you just drag one of the highlighted files they will all be moved. To quickly select all of the files in a folder, click to select the first one as normal, then hold down \textit{SHIFT} and click once on the last file.

Instead of dragging, you can right-click on selected files and choose \textit{Cut}, then right-click somewhere inside the new folder and \textit{Paste}. If you choose \textit{Copy} rather than \textit{Cut} it will create copies rather than moving the original files.

\textbf{Changing Folder Views}

You can change how the files in a folder appear by using the \textit{View} menu at the top of a window. Try experimenting with the different views (such as Thumbnails, Tiles, Icons, List, Details) to see which you prefer to work with. For example, the \textit{Details} view gives you lots of information about the files, whilst the \textit{Thumbnails} view is useful for collections of picture files as it displays a gallery of small thumbnail previews of the image.

\textbf{Moving/Deleting/Copying Files And Folders}

The menu that appears when you right-click on a file or folder gives you access to useful options such as \textit{Cut}, \textit{Copy}, \textit{Delete}, \textit{Rename}, as well as \textit{Properties} which gives you more information about the files.

You can delete, cut, copy, paste and drag folders just as you can files. Remember that all files inside the folder will be moved or copied as well.

\textbf{Creating Shortcuts to Files and Folders}

From the menu that appears when you right-click a file or a folder, you should also see an option to \textit{Create Shortcut}. If you click this option, a shortcut will be created which points to this file or folder.

If you double-click a shortcut, it has the same effect as double-clicking the folder or file the shortcut is pointing to. It is effectively a link which directs Windows to a certain file or folder.

For example, if you right-click on the Test Folder and \textit{Create Shortcut}, a shortcut will appear. Shortcuts look like the file or folder they are pointing to, except that they have a small arrow in the bottom-left corner.

A shortcut like the one you have just have created for your Test Folder isn't of much use if it's in the same place as the original file or folder. Instead, drag (or \textit{Cut} and \textit{Paste}) the shortcut like you would a file or folder, to somewhere more useful for example the Desktop. Alternatively, if you right-click a file or folder and select \textit{Send To} then \textit{Desktop (Create Shortcut)}, this will automatically create a shortcut and place it on your desktop.

You could also create a separate folder on your desktop if you want to store your collection of shortcuts all in one place for easy access to your favourite files.
Clean Out And Clean Up Files

This article describes how to tidy up unnecessary files to gain more disk space and help Windows run better.

Introduction

The more you use your PC, the more it will collect junk files that you no longer need, taking up unnecessary disk space. It is therefore a good idea to regularly clean out your system, getting rid of the files you no longer need to make space for new ones.

You can also run maintenance programs which can 'defrag' your files – in other words clean up and arrange them in a way which makes it easier for your PC to find. By doing this, you can improve the speed at which Windows runs programs.

The Recycle Bin

When you delete a file, usually this just means it has been moved to the Recycle Bin. If you do not regularly empty your Bin, the files inside may take up valuable disk space.

Double click the Recycle Bin icon on your desktop to see which files are currently stored in there. If there are any files in the Bin that you want to keep and put back in the original place you deleted them from, right-click on the files and select Restore. If you are happy you no longer require any of the files in the Recycle Bin, you can remove them from your computer completely by right-clicking the Recycle Bin icon and selecting Empty recycle bin.

You should empty your Recycle Bin regularly, at least once a week.

Remove Temporary Files

Temporary or junk files are left over by programs and are usually no longer needed. They waste space and that may eventually slow your PC down.

Internet Explorer stores many of the files used on the web pages you visit so that next time you go to a site it doesn’t have to download the same files again. However, this can build up over time and take up a lot of disk space.

In Internet Explorer 6 click on Tools then Internet Options. Under the section Temporary Internet Files on the General tab, click Delete Files. Tick Delete all offline content and click OK. When finished, click OK to exit the Internet Options window.

In Internet Explorer 7 click on Tools then Internet Options and look for the section Browsing History and click the Delete button underneath. Next click the Delete Files button next to Temporary Internet Files.
The System Restore facility is a useful safety feature but it can also use up a lot of space, so occasionally it is worth clearing out the old restore points.

To do this, go to Control Panel, click on System then on the System Restore tab. Tick to turn off System Restore and click Apply, this will clear out all old restore points. Now un-tick to turn System Restore back on and use the slider to specify the amount of disk space you want it to use for future restore points.

**Disk Cleanup**

The Disk Cleanup system tool allows you to clean out Windows components and programs you no longer need, and remove temporary files.

From the Start menu, click on Programs> Accessories> SystemTools> Disk Cleanup.

The main Disk Cleanup window shows two tabs - Disk Cleanup and More Options. In the Disk Cleanup tab window, put a tick in the following boxes if you wish to clean out these unnecessary files:

- Downloaded program files
- Temporary internet files
- Recycle bin
- Temporary files

Click on the More Options tab and you can choose to get rid of unwanted Windows components, remove installed programs you no longer use, and remove all but the most recent System restore point.

When you have selected everything you want to clean up, click on OK then Yes to confirm you want to begin the Disk Cleanup process.

**Defragmenting Your Hard Disk**

Disk Defragmenter helps Windows arrange files on your Hard Disk in a way that makes it easier and faster for it to find your programs.

From the Start menu, click on Programs> Accessories> SystemTools> Disk Defragmenter.

It is recommended that you read the Defragmenter Help manual before beginning the defragmentation process. Click on Help from the menu at the top of the Disk Defragmenter window.

Defragmenting can take anything from a few minutes to several hours depending how fragmented the disk is, during which time you should not run any other programs.

Disk Defragmenter requires 15% of free space on your hard disk to work with. If you do not have enough space you will need to delete some files. To start the defragmentation process, click the drive that you want to defragment, and then click Defragment.
Preventing RSI

This article features gives information about the dangers of RSI and advice on how to stay healthy when using your PC.

RSI

It is all too easy to neglect your health while you're busy browsing the Web, using your PC at work or playing games.

Using a computer for more than a few hours a day can put you at risk from RSI (Repetitive Strain Injury).

RSI is used to describe many different types of soft tissue injury including carpel tunnel syndrome and tendonitis. It is usually caused by repetitive motions, poor posture and stress, and has the potential to cause crippling disability and pain.

For people whose jobs require frequent use of computers it may seem there is no way to avoid this problem, but fortunately there are a few things you can do to try and protect yourself:

Make sure to take regular breaks away from your PC if you can; get up and walk around for a few minutes each hour.

Also, try and alternate between using your keyboard and mouse rather than relying on the mouse for everything. And when you do use your mouse, move with your shoulder rather than putting all the strain on your wrist.

You can buy mouse mats that have gel wrist support. You may also want to look into buying one of the special keyboards available which have been designed to be more comfortable to use.

If you have a joypad you could use a program like JoyToKey to map mouse and keyboard controls to your controller to give your wrist and fingers a change from the same mouse and keyboard positions all the time.

There are many websites such as this RSI Info page on how to avoid or treat RSI.

There is also a useful program called Workrave that can help prevent RSI. The program reminds you to take breaks at set times as well as letting you set micro pauses and daily limits.

Workrave even has a series of short exercises for you to carry out, with pictures demonstrating certain actions such as stretching your arms, moving your shoulders and focussing your eyes.

You can download Workrave for free from www.workrave.org
Useful Programs And Utilities

This page is a list of links to web sites where you can download useful programs.

There is also a brief description of what each one does.

The various software tools below can be used to remove viruses, create music, play video files, browse the Web, compress files and more.

- **Ad-Aware** - spyware remover
- **Adobe Reader** - read PDF files
- **Audacity** - sound editor
- **AutoReplace** - replace text in multiple files
- **AVG** - anti-virus
- **Buzz** - music creation program
- **Coffee Cup Free FTP** - FTP program
- **DivX Player** - play DivX media files
- **DosBox** - DOS emulator
- **Extract Now** - Zip/archive handler
- **FileZilla** - FTP program
- **GIMP** - image editing
- **HTMLKit** - HTML tools
- **ICQ** - messaging tool
- **IrfanView** - image browsing/conversion
- **KeyNote** - notepad and information manager
- **Media Player Classic** - play music and video files
- **Monkey's Audio** - lossless audio compressor
- **Mozilla Firefox** - web browser
- **Notepad++** - Notepad replacement
- **Open Office** - Microsoft Office alternative
- **Opera** - web browser
- **RazorLAME** - mp3 encoder
- **Samurize** - desktop enhancements
- **Spybot** - spyware remover
- **Winamp** - media player
- **WinRAR** - RAR archive handler
- **WinZip** - Zip archive handler
- **ZoneAlarm** - Firewall software
The Best Free Software

This article features information about open source software that you can download free, and can be used as an alternative to expensive commercial programs.

What Is Open Source

If you want to write a letter on your PC, play videos, create music files, or edit images, you need to use a piece of software to help you perform that task and that usually means shelling out cash.

However, there is an alternative - a huge range of software available on the Internet to carry out virtually any task you can think of. And it's absolutely free.

Open source software is software whose code is made available to anyone who wants to copy or modify it. This way, the software can adapt, evolve and improve through input from its community of users.

Where To Download

SourceForge.net is the first place to look to find and download open source software. Categories include desktop applications, games, multimedia, and security.

Wikipedia features a large list of open source software in categories such as data storage, document editing, education, games, media, networking and security.

Ten Useful Programs

10 of the best open source software are listed below:

- OpenOffice.org - office suite, alternative to Microsoft Office
- Mozilla Firefox - web browser, alternative to Internet Explorer
- GIMP - image editing, alternative to Photoshop
- Notepad++ - text editor, alternative to Windows Notepad
- phpBB - build messageboards
- RazorLAME - encode audio to mp3s
- Audacity - audio file editing
- Media Player Classic - play music and video files
- FileZilla - transfer files
- 7-Zip - file compression
Create Documents In Microsoft Word

A beginners guide to using Microsoft Word to create documents and work with text and graphics.

Why Use Microsoft Word?

Microsoft Word is a word processor which can be used to edit many types of document including letters, essays and web pages. You can type text, choose different sizes, fonts, and colours; you can also insert graphics and add tables and charts.

Getting Started

Open Microsoft Word by clicking on Start > All Programs and selecting Microsoft Word from the list.

Word will open with a blank document. You will see the flashing cursor at the top left corner of the page, ready for you to start typing.

If you hold your mouse over any of the icons in the menu bars or toolbars, you will see a quick description of what those buttons do.

If you can't see any of the toolbars mentioned in this article (mainly the Standard and Formatting toolbars), you may have to instruct Word to show them by clicking View then Toolbars and putting a tick by any toolbars you want to show.

If you can't see any of the buttons mentioned below on your toolbar, look for the button at the edge of the screen. This is the More Options button which will allow you to select which buttons you do or don't want to display.

Using Templates

You can save yourself some time by using some basic Templates and Wizards to help you construct your document.

From the File menu, click New and select the option for Word Templates. You can select from a range of document types including letters, brochures and memos, all laid out ready for you to insert your own text. You can also choose to use Wizards that work by asking you questions about the document you wish to write.

Working With Text

To select a piece of text you have typed, you need to highlight it by holding the left mouse button and dragging your mouse over the words. Alternatively, if you double-click a word, that word is selected, and if you triple-click anywhere on a line, the whole line will be selected.
You can change the look and layout of your selected text using the **Formatting** toolbar at the top of the screen. Some of the buttons can be pressed on or off, while others have a drop-down menu activated by pressing the \( \text{button} \) next to them, giving you a choice of options.

You can use the Font \( \text{bar} \) to select different types of font styles, and the Font Size number bar to make the text smaller or larger.

You can choose to make highlighted text **Bold**, **Italic**, or **Underlined**. You can also justify and align the text using the **Align** buttons.

Use the **Bullets** buttons to insert numbering or bullet points before the text. You can also indent the text forward or back.

Choose the colour of the text by clicking on the small drop-down arrow by the side of the font color button. If you change the color without highlighting any text first, then any text you have already written will stay the same colour but any text you type now will have this new colour. To change the colour of existing text, highlight it first then click the font button.

Select some text and you can then **Cut**, **Copy** and **Paste** it using the **Edit** menu or the buttons. Select the text, choose **Copy** then move your cursor to where you want the text to go, then **Paste**. A copy of the original text will now appear. If you choose **Cut** instead of **Copy** the original text will be moved rather than copied.

The **Format** menu allows you to change things like columns, bullets or numbering.

Click on **File** then **Page Setup** to adjust margins, the layout of your page and its orientation (Portrait or Landscape).

You can check the spelling of your text by clicking on the **Tools** menu and selecting **Spelling and Grammar**, or by clicking the \( \text{button} \). You can choose to ignore any words found by the spellchecker, or replace them with an alternative spelling.

From the **View** menu select **Toolbars** and you will be able to select which toolbars you want to work with. These are many different menus which provide you with easy access to tools for tasks such as drawing, creating tables and working with pictures.

To undo any mistakes you have made, press the \( \text{button} \). If you then want to redo the action you previously did, press the \( \text{button} \).
Inserting Graphics

From the *Insert* menu, select *Picture* then *From File*. You can then browse to the location of an image file on your hard drive. When you have selected the one you want, click *Insert* to place it in your document.

To insert Clip Art into your document click on the *Insert* menu, *Picture* then *Clip Art*. Select the graphic you want from the galleries available and click *Insert* to place it in your document.

To resize an image, click once to select it then click and drag the handles that appear around the edges of the image. If you use the corner handles the proportions of the image will stay the same as you resize it.

Printing Your Work

You can preview your work to see how it will look when printed. Choose *File* then *Print Preview* or click the button. To return to the normal view click *Close*.

You can select your printing options (such as which pages to print and how many copies to make) by clicking on *File* then *Print*. To print your work immediately without making any changes to your standard settings, press the button.

Saving Your Work

When you want to save your work, choose *File* then *Save As*. You will be asked to give your document a name, and should you need to you can also change the filetype from its default setting (Word Document) to save as a text file or Web page instead.

When saving the same document later, you do not have to use Save As each time, instead you can select *File* then *Save*, or just click on the button.

When You Have Finished

Once your work is saved, you can close the document by clicking on *File* then *Close*. You may be asked if you want to save any changes you have made. Click *Yes* if you have made any changes to your document since the last time you saved it.

To start another document, click on *File* then *New* or press the button. To open an existing file such as the one you have just saved, click *File* then *Open* or press the button. Locate the file you want and click *Open*.

To exit Word completely, use the X (Close) button at the top-right of the window.

There is a lot more to discover in Word and it is a powerful program. Click the *Help* menu for more information and tips.
Work With Pictures In Microsoft Paint

A beginners guide to using the Microsoft Paint software to work with image files. How to edit existing pictures, and print and save new image creations.

Introduction

Microsoft Paint is a free graphics tool installed on Windows PCs.

Paint is a simple introduction to image editing and allows you to resize and edit pictures. It gives you the ability to zoom in, create text, draw simple shapes and fill them with colours.

You can also convert and save images into different picture file formats.

To start Paint, click on the Start menu then All Programs > Accessories > Paint.

Create A Picture

There are toolbars running along the side and base of the Paint window with which you can draw or alter your picture. If you can't see these icons, go to View and make sure Tool Box, Color Box and Status Bar all have ticks by them. If you hold your mouse pointer over one of the icons for a moment, a small description will appear.

To start a new picture, click File > New. To change the size of the canvas area, go to Image > Attributes where you can adjust the height and width. As you move your mouse pointer around the canvas you will see the co-ordinates change on the Status Bar below.

Double-click a colour on the Color Box below the canvas or click Colors > Edit Colors to select from the basic colour palette, or define custom colours if you don't see the colour you want to use.
Tool Box

The Tool Box down the left of the screen gives you various options for creating and selecting parts of your picture.

For example, to draw a box click the Rectangle tool and then on the canvas, click and drag the cursor to create a box which will be outlined in your chosen colour.

Pick a different colour and then click the Fill With Colour button on the left menu. Now click anywhere inside your box to automatically fill it with that colour.

Experiment with the other drawing tools on the menu which include lines, curves, and ellipses. Notice that when you click on certain tools you will see other options appear below the menu. For example, the brush tool will display a range of brush types.

Use the pencil or brush tool along with the Magnifier zoom tool for detailed drawing.

The select tools allow you to edit or apply effects to particular areas of your drawing. Use them like the drawing tools by drawing an outline around the area you want to select.

After selecting a particular area, you can use the Edit menu to Cut, Copy and Paste.

Use Edit > Select All to make the entire canvas the current selection. To wipe or clear the canvas, use Image > Clear Image.

Work With An Existing Image

To open an existing picture file, click File > Open. Browse to where the file is located on your hard drive, click to select it then click Open.

To insert a picture onto an existing canvas, use Edit > Paste From and browse to where the picture is located on your hard drive. Click to select the picture you want then click Open.

The picture will now appear on your canvas. The image will have a dotted outline meaning you can move it by clicking on it and dragging it, or you can resize it by clicking on the corner handles.
To change the appearance and size of a picture, use \textit{Image > Stretch/Skew} to stretch in percent and skew in degrees. For example, if you have a picture you would like to double in size, enter 200\% in the horizontal and vertical boxes.

From the \textit{Image} menu you can also choose to \textit{Flip/Rotate} an image, or \textit{Invert Colors} which gives you a kind of 'negative' effect.

\textbf{Printing Your Work}

You can change the orientation, margins, paper size and centering of your image in \textit{File > Page Setup}.

Use \textit{File > Print Preview} to see how your image will look when printed. Click \textit{Close} to return to the main view again, and click \textit{File > Print} when you are ready to start printing.

\textbf{Saving Your Work}

To save your work, click \textit{File > Save As}.

You will be able to choose where to save the picture on your computer, what name to call it, and what filetype it will be saved as (such as \texttt{.BMP}, \texttt{.JPEG}, or \texttt{.GIF}).

Bitmap (\texttt{.BMP}) is the standard image filetype but it can be very large, while JPEG and GIF are 'compressed' versions and use less disk space, though the quality is reduced.

You will find that most people nowadays tend to use the JPEG format, which gives a good balance between quality and file size.

Many of the more advanced image editing programs also allow you to set the precise amount of compression applied to a file when converting it to JPEG.

Compressed picture files like JPEGs are especially useful on the Web and when you want to send pictures with e-mails, as they are smaller and therefore reduce the time that it takes to send and receive them.
Play Music And Video Files

A guide to using the **Winamp** media player, a free program that is capable of playing many types of music and video files.

**What Is Winamp?**

**Winamp** is one of the most popular media players available.

Not only is it easy to use and capable of playing many different types of Audio and Video files, it is also free.

Go to [www.winamp.com](http://www.winamp.com) and click the *Download* link then click *Get Basic* (Free). Next choose the *Full* version of Winamp.

You may be taken to another web site (such as Download.com), click *Download Now* and save the file to your hard disk.

**Installing Winamp**

Double-click the file you downloaded to begin installation. Click *I Agree* on the license agreement and then choose the *Full* install and click *Next*.

Now you can choose which icons you want, and which filetypes should be associated with Winamp so it is the default player for those media types. If unsure, leave them all ticked (except any software or music offers) and click *Next*.

Leave the Destination Folder as it is and click *Next*. If you have several user accounts on your PC, you can set up Winamp to use *Separate settings per user account*. Otherwise choose *Shared settings for all users* and click *Next*.

Now you will be asked to select your Internet connection type, for most users this will be the default *Always connected* setting. Click *Next* to proceed.
You can now choose the 'Skin' you want. This determines the theme or look of Winamp. The default Modern should be selected unless your PC is a very slow machine, in which case try the Classic skin instead. You can always change the Skin later in Winamp by going to Options > Preferences > Skins.

Click Install to begin the installation process. You will be asked to reboot your PC so save any work you have open and click OK. Your PC will now restart.

**Using Winamp**

Double-click the shortcut to Winamp on your desktop. Alternatively, use the Start menu > All Programs list and look for Winamp.

The first time Winamp starts you will see a User Information window. Tick Do not ask me again until next install and click Later.

You can now use the Add Media to Library option to point Winamp at any folders you have on your computer that contain music or video files. This allows the program to create a library of all your media files for easy access. Otherwise tick Do not show me this again and then click Close.

Winamp has several parts which appear in different windows such as Playlist Editor, Media Library and Video. These windows can be arranged to suit you by clicking on the title bar of the window and dragging it to where you want. Close a window by clicking the X in the top-right corner. If you can't see these windows, click View and put a tick by the windows you want to appear.

Winamp supports many types of audio files such as .WAV and .MP3. To start playing some music, click File then Play File in the main Winamp window, browse to a song file and double click it. It should automatically start playing.

You can also click and drag a song file to the main window to start playing it now, or alternatively drag several song files to the Playlist Editor window where you can queue up a list of songs to be played one after the other. In the Playlist Editor window you can click and drag songs up and down the queue.

Double-clicking any music file will automatically open Winamp and start playing. Alternatively, select a folder or several song files, right-click and you should see an option to Enqueue in Winamp. These tracks will now be added to the playlist.

The main window features song control buttons such as Skip track forward/back, Play, Pause, and Stop. There is also a volume slider as well as buttons to Repeat songs and playlists after they have played, or Shuffle the playlist so the songs are played in random order.
Video Files

Winamp also supports various Video filetypes such as .MPEG and .AVI.

As with audio files, you can double-click, or right-click and select Play in Winamp to start playing. The Video window will automatically appear if it is not already open.

Right-click the Video window to choose screen size and other video options. Click and drag the corners to resize the window.

Playlists

If you wish to save a playlist you have created, click the Manage Playlist button and choose Save Playlist.

You can print a copy of your playlist by clicking the Misc button and selecting Misc then Generate HTML playlist. This opens up a Web browser window with a page containing your playlist, and you can then print it out by going to File and Print from your browser menu.

If you close Winamp, when you open it later you may find the last playlist you played is still in the Playlist Editor window. Hit CTRL+N if you want to clear the current playlist and start a new list.
Write CDs And DVDs

This guide describes how to use DeepBurner Free to burn data or audio to CD or DVD.

Introduction

There are many commercial CD/DVD writer programs that you can use which offer a lot of features for creating data and audio CDs and DVDs. This tutorial uses a simple free program called DeepBurner Free.

CD/DVD writer drives are able to "burn" discs so that you can create your own data, music or video discs, especially useful for backing up large amounts of data.

There are two main categories of writeable discs you can buy: Recordable discs such as CD-R or DVD-R or DVD+R are discs that can only be written once, whereas Re-Writeable discs such as CD-RW or DVD-RW or DVD+RW can be written over many times.

Install DeepBurner


Double-click the file you downloaded to run the install program. During setup, use the Next button to move through the options screens.

Select your language and agree to the License Agreement. Leave the destination folder as it is, and select the Full setup.

Leave the program group as DeepBurner, and wait for the program to install. If you want to, you can read the Read Me file which contains some information about the program. When ready, click Finish.
Getting Started

Insert the recordable or re-writeable CD or DVD you want to burn into your drive.

The program can be started by double-clicking the DeepBurner desktop shortcut, or by clicking on the Start menu then All Programs > DeepBurner > DeepBurner.

First you will need to choose whether you want to burn a Data CD/DVD or an Audio CD.

A Data disc can contain any kind of file and is useful for storing and backing up your PC files. An audio CD is like an album you buy from a shop; it stores music files as audio tracks and can be played in a CD player or on your PC.

Data Disc

To burn a disc of data files, select Create data CD/DVD and click Next.

The New Project window will appear and you will be given the option of creating a multisession disc. If you choose this option, it means you can burn more files to the same disc at another time, if not you will have to start from the beginning and burn all the files again.

Now on your desktop, double-click the My Documents icon or open a new window, and locate the files you want to burn.

Click and drag the files from the window into the DeepBurner box below where it says Name, Size and Description.

You can continue adding the files you want to burn to this list, but keep an eye on the bar below which shows how much space your files will use up on the disc. An average CD allows a total of around 650MB - 700MB and an average DVD is around 4.7GB.

When you are finished, click the Burn disc icon from the menu on the left, then click the Burn button to begin writing your files to the CD/DVD.

To ensure burning is successful, it is best not to run other programs and to leave your PC alone until it has finished.

Time Remaining shows how long before the burning is finished. When it is done, the disc will be ejected.

When the message 'Burn completed successfully. Please insert next disc' appears, click Cancel and then close DeepBurner. Click No if asked to Save Changes.
Audio Disc

If you want to burn a CD-R disc of music tracks, select *Audio CD* as Project Type.

Click and drag song files such as MP3s into the box in DeepBurner, as with data files.

With Audio CDs you can rearrange the files into the order you want them to play on the CD. Click to select a particular track and use the arrow buttons above to move the file up or down the list.

When finished, click the *Burn Disk* icon and click the *Burn* button.

DeepBurner will now convert your song files into audio tracks and then start writing them to the CD.

Erase Re-Writeable Disc

On the *Burn disc* window, the *Erase* button allows you to wipe a RW disc so it is blank ready for burning.

Use *Quick erase* unless you have previously stored private data on the disc, in which case it may be better to use *Full erase* to completely remove any trace of the previous data.
Compress Files

Some files can be too big to be quickly transferred across the Internet or between PCs.

This guide describes how to use the WinZip program to compress files for easier transfer and storage.

What Is WinZip?

When transferring files from computer to computer via cable, disk or Internet, it is often necessary to "compress" files to make them smaller so they can be sent more quickly.

The files are not damaged or changed, just stored in a different way. A good analogy is to think of it like taking a large letter, folding it up and putting it inside a small envelope. You send the envelope which now takes up less space, but at the other end the envelope can be opened and the large letter folded out again.

This is the advantage of using compressed files. You take a large file or group of files, compress and place in one small compressed file, then send. At the other end the contents can be "extracted" back to their original size and used as normal.

WinZip is the most well-known of many programs able to compress files, in this case to what are known as Zip files which have the filename extension .zip

Installing WinZip

You can download a trial version of WinZip from www.winzip.com

After the trial period is over you will be reminded to purchase a License to continue using the program.

Choose a site to download from and click Download Now. Choose to Save To Disk and choose a location on your computer to save to.

Double-click the WinZip file you have downloaded to begin installation. Click Setup then OK to install to your Program Files folder. As you proceed through the setup options you will need to click Next to move on to the next screen.
Click Yes to agree to the License Agreement. You can now view or print a Quick Start guide if you wish to. Choose Start with the WinZip Wizard.

Choose Quick Search and after a few seconds WinZip will finish making a list of your folders. The setup will also need to associate WinZip with various filetypes. When WinZip Setup has finished, click Close.

Using WinZip

To start the program, double-click the WinZip shortcut on your desktop, or alternatively click on the Start menu then All Programs > WinZip > WinZip.

Click on Use Evaluation Version. You should now see the WinZip Wizard, which helps you perform the most common tasks associated with WinZip. Click Next and for this example, Create A New Zip File.

Choose a filename such as "ZipTest" which will be saved to the default folder, or use Browse to choose a different folder, enter the filename and click OK.

Click Next. Use the Add Files button to add the files you want to compress, or you can click and drag them into the empty box. When you have added the file or files you want to compress into this Zip file, click ZipNow then Finish.

WinZip will close and if you now look in My Documents or whichever folder you specified earlier, you should see a .zip file called "ZipTest". To open this or any other Zip file, in Windows XP you can double-click it as if it were a normal folder. From here you can drag the files out, which will extract them so they can be used as normal.

Alternatively, right-click the file and choose Open With WinZip. Click Evaluation Version and you should see the Wizard again.

Click Next then UnZip or Install from "ZipTest.zip". Click Next and choose a folder to extract the contents of the Zip file to (the default location is a folder called Unzipped in My Documents).

Click Unzip Now. In the folder you specified you should now be able to see the files you originally compressed in the Zip file, extracted and ready to use again. Click Finish in WinZip to close the program.

More Help

For more information about WinZip's other features, read the QuickStart guide or click on Help from within the program.
Start Using Internet Explorer 7

Internet Explorer 7 is the latest version of Microsoft's free web browser. This guide explains how to set it up and how to use the new features.

Introduction to IE 7

Internet Explorer 7 (IE 7) is the long-awaited new version of Microsoft's leading web browser. It has been designed to be much safer, it has new features to improve browsing and it has better handling of web page code.

IE 7 is free to download and also features optional plug-ins so that you can add tools for improving things like downloading and security.

If you currently use a different browser such as Firefox, you can install IE 7 without affecting your other browser.

Users of Windows XP with Service Pack 2 can download the IE 7 setup file from this link: Download Internet Explorer 7

If you have Automatic Updates enabled on your PC you will receive IE 7 as an update. You will be given the choice to install the program or not.

Alternatively, visit www.windowsupdate.com and choose the Express install option which will download any necessary updates including IE 7.

Features of IE 7

IE 7 has a number of improvements over previous versions of the browser:

- **Tabbed Browsing**: Open multiple sites within the same window and use tabs to move between them
- **Pop-up Blocker**: Prevents pop-up windows advertisements
- **Phishing Filter**: Warns you about dangerous fake web sites
- **RSS Feeds**: Shows RSS news feeds available on a site
• **Printing:** Automatically fit web page text on the printed page
• **Zoom:** Magnify parts of a web page to read more easily
• **Search Box:** Search with your preferred search engine from within the IE 7 window
• **Favorites Center:** Easy access to your Favorite bookmarks
• **Security:** Color-coded warnings and security information about the site you're visiting

**Installation**

If you downloaded the Internet Explorer setup file, double-click it to begin installation. Click *Run* if you get a security warning.

You should temporarily switch off any anti-virus or anti-spyware security programs you have running. Usually there will be an icon on the taskbar that you can right-click and choose *Close* or *Exit*. Remember to make sure they are switched back on after IE 7 has been installed – often this happens automatically after restarting your PC.

Click *Next* and then *I Accept* on the agreement screen. Now you will be asked to confirm your copy of Windows is genuine by clicking the *Validate* button.

The next screen allows you to install the latest Windows updates. Click *Next* and any necessary updates will be downloaded and installed. This may take a few minutes.

When IE 7 has finished installing you will need to restart your PC. Save any work and click *Restart Now*.

**Starting IE 7**

Start IE 7 using any existing Internet Explorer shortcut you have on the desktop or from your *Start Menu* under *Programs > Internet Explorer*.

If you use *ZoneAlarm* or other firewall program you may need to confirm you want to allow this changed version of Internet Explorer to access the Internet.

**Customize Settings**

You will now see a page allowing you to customize your settings.

First choose your default search provider (your favourite search engine). This will be used for the **Search Box** that appears in the top-right of the IE 7 window. Tick to either use your current provider or select from a list of other search providers.

There are several optional settings you may wish to set now:

• **Phishing Filter** - tick to turn this on. It will warn you about dangerous fake web sites
• **See webpages more clearly** - the ClearType option attempts to make text easier to read. If you find it makes it too blurry you can turn it off later
• **Help customize webpages to your current location** – you can choose your region and language to help web sites show location-specific content
• **Help improve Internet Explorer** - this collects data as you use IE 7, although it should be anonymous it is recommended you leave this blank

Now click *Save Settings*.

On the next screen you have three choices: take a quick tour to learn about IE 7’s new features, choose to install optional plug-ins, or go straight to your homepage.

If you choose the plug-ins option you will be taken to [www.ieaddons.com](http://www.ieaddons.com) where you can download add-ons that improve browsing, such as tools for filling out forms automatically, media players and download managers.

### Navigating IE 7

The new-look IE 7 includes some big changes to the menus and icons so it’s worth spending a little time learning what they are. You can do this by holding your mouse over the menu buttons and reading their descriptions.

The *Forward* and *Back* arrows remain in the top left and there is also a drop-down list of recent pages. Below these are the *Favorites Center* and *Add To Favorites* buttons for managing your site bookmarks.

The *Stop* and *Refresh* page buttons now appear to the right of the *Address bar*.

A new feature for IE7 is the *RSS* feed icon which shows you any *RSS* news feeds available on the site you are visiting. If there is a feed available the icon will appear orange. To add a feed to your subscriptions, click the down arrow by the icon to select a feed and then click *Subscribe to this feed*.

You will notice the typical Windows file menus no longer appear in IE 7 (though you can bring them back by pressing the *ALT* key), and there have been other changes too - for example, the old *View* menu is now the *Page* menu.

In the *Page* menu there are options for changing *Text Size* (which you can also do by holding the *CTRL* key, and then either using the + and – keys or your mousewheel) and also an option to *Zoom* which allows you to magnify part of a web page. The *Zoom* option also appears at the bottom-right of the screen on the *Status Bar*.

You can access your browser settings by clicking on the *Tools* menu. Click *Windows Update* to get the latest security updates for Windows. Click *Internet Options* to access a range of options including the ability to set your homepage. Click on the *Advanced* tab for more detailed options.

If you have ClearType on and you do find text is too blurry, un-tick *Always use ClearType for HTML* under the Multimedia section on the *Advanced* tab. Click *OK* to save your settings. You will need to close then restart IE 7 for the change to take effect.
Tabbed Browsing

Tabbed browsing is a feature new to Internet Explorer but common in other browsers such as Firefox and Opera.

This allows you to open multiple web pages in the same IE window that you can switch between by clicking on their respective tabs at the top of the screen.

To try this, instead of left-clicking a web page link, right-click it and select Open in New Tab, or alternatively press your middle mouse button.

A new page will be opened but your current page will still be on-screen. You can access the new page by clicking on the new tab which appears at the top above the page, and has the page's title. To close the tab, click the X button on the tab or right-click and Close.

You can keep one tab open and close all others by right-clicking it and selecting Close Other Tabs.

To the left of the tabs is an icon called Quick Tabs which appears when you have more than one tab open. Click this to see at a glance all the pages you have open.

If you try to close IE 7 when you have multiple tabs open you will be asked if you are sure you want to close all the pages you have open.

Managing Favorites

Favorites have also changed in IE 7. Now there is a Favorites Center for organising your site bookmarks.

Click the Favorites Center button at the top left of the screen and the Favorites window will appear over the left of the site you are visiting. To fix it in a separate window pane away from the page as in IE 6, click the Pin the Favorites Center button in the top right of the Favorites Center window.

You can use the History drop-down menu to find sites you have visited before.

To add a site to your Favorites list, right-click the page and select Add to Favorites, or click the Add to Favorites button at the top left of the screen.

Printing

Printing has been improved in IE 7. Now pages will be automatically resized so that all content fits on the printed page.

You can set margins, paper size and orientation by clicking the drop down arrow to the right of the Print icon and then selecting Page Setup.

You can also remove the header and footer from the printed page.
Security

There are a number of new security features that have been introduced in IE 7, to make this a much safer browser than IE 6 which had many security flaws and vulnerabilities.

The built-in **Pop-up Blocker** prevents pop-up advertising windows, and the **Phishing Filter** lets you know if you are visiting a site that is a security risk and may attempt to trick you into giving your personal information.

The Address bar will change colour to show if a web site might be dangerous – yellow means you should proceed with caution, whereas red indicates a known phishing site and you should not proceed.

The Padlock icon which used to appear on the status bar below a web page now appears next to the address bar. Clicking on the Padlock gives you more information about the site to help you decide if it is safe to use.

You can clear your browsing history at the end of a session by clicking on the **Tools** menu then **Delete Browsing History**.

You can then choose what to delete – your History of visited sites, Passwords, data entered in Forms, Cookies which save your web site preferences, or Temporary Internet Files.

Temporary Internet Files are web site files – such as images and media – that are stored so that the same files do not have to be re-downloaded each time you visit a site.

However, these temporary files can build up over time and end up using unnecessary disk space, so it is worth deleting these occasionally.

Although Internet Explorer 7 is a much safer browser than previous versions, it is still important to protect your PC online and to make sure you install security software and keep it up-to-date.
Browse The Web With Firefox

The free Firefox web browser offers a safer alternative to Internet Explorer for visiting web sites.

What is Firefox?

Mozilla Firefox is an alternative to the Internet Explorer web browser. The way it has been created means it is safer to use and more flexible than Internet Explorer.

It is free to download and also features optional extensions so that you can add tools to improve things like downloading and security when browsing the Web.

Firefox 2.0 was released in October 2006 and brings new features including Phishing protection and Tab History.

You do not need to remove Internet Explorer to install Firefox - in fact it is useful to have both available to choose from, as there are one or two websites that require Internet Explorer to use, such as Windows Update.

You can have Firefox use the same settings and Bookmarks (Favorites) you had in Internet Explorer.

Firefox's Features

- **Tabbed Browsing** - instead of opening a separate browser window for each site you want to visit, you can open multiple sites within the same window and use tabs to move between them
- **Add-Ons** - download a range of useful plug-ins to improve browsing and security
- **Download Manager** - organizes your downloads by showing them in a single window
- **Pop-up Window Controls** - allow or suppress pop-up windows
- **Privacy Options** - change settings for handling cookies and clear your history of visited sites
- **Phishing Protection** - warns you if visiting a fake site that may attempt to steal your details
• **Session Restore** - if your system crashes, you can restore your previous session (open windows, tabs, text in forms, in-progress downloads)
• **Tab History** - restore tabs you have accidentally closed
• **Search Box** - search within the browser with your favourite search engine and get suggestions as you type
• **Inline Spell Checking** - check spelling of text you enter in forms

**Installing Firefox**

Mozilla Firefox can be downloaded from [www.mozilla.com](http://www.mozilla.com). Click on *Download Firefox - Free* at the top of the page and save the file to somewhere on your computer (e.g. the Desktop or My Documents).

Close your browser and double-click the downloaded **Firefox Setup** file to begin installation. Click *Next* through the various screens and click to accept the License Agreement.

Choose the **Standard** setup type. Wait while Firefox is installed then click *Finish*. Firefox will now launch. If you use **ZoneAlarm** or other firewall program you may need to confirm you want to allow Firefox to access the Internet.

If you have a version of Firefox already installed, the setup program will check if you require any updates for your browser plug-ins.

**Starting Firefox**

Firefox will start automatically after install. To start Firefox in the future, double-click the Firefox shortcut icon on your desktop or go to your *Start Menu* and click on *All Programs > Mozilla Firefox > Mozilla Firefox*

**Importing Your Internet Explorer Favorites and Settings**

Firefox can import your existing settings from Internet Explorer.

From the menu at the top of Firefox, click on *File* then *Import* and choose Microsoft Internet Explorer.

Firefox will attempt to import your Bookmarks (Favorites), cookies, stored passwords, and other data.

**Tabbed Browsing**

One of Firefox's most useful features is the ability to open more than one web page at a time within the same browser window and then use 'tabs' to move between them.

This saves you having to have lots of browser windows open at the same time to move between several different web sites or pages.
Try this by right-clicking on any link (either on a web page or from your Bookmarks list) then select *Open Link In New Tab*. If you have a mouse with a middle-button, pressing this on a link will open a new tab too.

At the top of the browser window, below the address bar and directly above the web page, you should now see tabs with the names of the pages you have open. Left-click on one of the tabs and the main window will change to show the page you have selected. This way you can have many different web pages open at the same time.

To close a tab, click the Close (X) button or right-click it and choose *Close Tab*. Click *Close Other Tabs* if you want to close all tabs except this one.

**Restore Closed Tabs**

In Firefox 2.0 you can re-open tabs that you have accidentally closed by clicking on *History* then *Recently Closed Tabs*.

Choose the page you want to restore. This will re-open the missing page and put its tab back on the Tab bar.

**Managing Bookmarks**

On the top menu click on *Bookmarks* then *Organize Bookmarks*. Here you can organise your favourite site links.

Click *File* in this window and you can create new Bookmarks and folders, and import and export your Bookmark lists.

When finished, close the Bookmarks Manager window. Now if you click *View* then *Sidebar* and select *Bookmarks*, your list of Bookmarks will be displayed along the left-hand side of the browser for easy access.

To bookmark a web page, right-click on the page and choose *Bookmark This Page*.

**Change options**

Click on the *Tools* menu then *Options* and you can change your settings for browsing, security and downloading files. Click on one of the tab headings for specific options:

- **Main**: here you can set your homepage and the location of your downloaded files
- **Tabs**: change how tabbed windows are handled
- **Content**: contains pop-up blocker options
- **Feeds**: handle RSS news feeds
- **Privacy**: change your privacy settings and clear your browser history
- **Security**: change your options for security features and passwords
- **Advanced**: accessibility, updates and connection options
**Change Text Size**

To change the size of web page text to make it easier to read, click on *View* then *Text Size* and increase or decrease the size of the text.

Alternatively, hold the *CTRL* key and scroll your mouse-wheel up or down to adjust the text size.

Depending on the way the particular web page was created, this may not work with all text, especially text you see in logos or other images.

**More Help**

You can use the program's *Help* menu to find out more about Firefox's features, and to *Check For Updates* to the browser.
How To Use Search Engines

This article explains how to find what you are looking for online with the help of a Search Engine web site such as Yahoo or Windows Live Search.

Introduction

If you don't know the exact address of a particular web site, or you have a topic in mind but don't know what web sites exist about that topic, then you need to use a Search Engine.

A Search Engine is like a catalogue of web sites where you can type some words and the Engine will search and then present you with a list of web sites relevant to your search.

Popular Search Engines

There are many different search engines available, among the most popular are:

- Windows Live Search
- Lycos
- Yahoo
- Ask
- Google
- Altavista
- Hotbot
- Looksmart

Example Search

This example will show how to use Windows Live Search to search for the web site homepage of popular online auction site eBay.

If you don't know the exact address of the eBay site, this is where a search engine comes in useful. Type in www.live.com into your browser address bar to go to the Windows Live Search web site.

Since you are looking for the eBay web site, type the word ebay into the search box. You don't need to type any capital letters when searching.

Press the Enter key on your keyboard and Live Search will look for web sites about your subject, then present you with a list of the results.

At the top of the results you will sometimes see Sponsored Links. These are links paid for by companies to ensure their web site is at the top when you search for certain words.
However, these are not always the most appropriate sites to match your search request. The proper results based on your search are the ones just below the sponsored links.

You should notice that the web site at the top of the list is www.ebay.com. If you now click the underlined title link of that result, you should find yourself at the eBay homepage.

If a search result you click is not what you are looking for, click the Back button of your browser to go back to the results page and try a different link, or a completely new search.

**What Kinds Of Things Can I Search For?**

In the search box you can type anything you like - words, names, places, dates; you can even type questions or problems, for example *my mouse has stopped working*.

Try to be as specific as you can if you have a particular problem, for example if you know your mouse is made by the company Logitech, typing *my logitech mouse has stopped working* will give you results that are more relevant to your particular problem, and hopefully on one of the web sites you should be able to find a solution.

Search engines will often ignore common words and phrases such as *where* or *what is*. So for example, typing *where is the eiffel tower* will have the same result as if you just typed *eiffel tower*.

**Advanced Searches**

In some search engines, near to the search box you will see other options to narrow your search to particular files such as Images.

Click this and when you type a search into the box, the search engine will look for picture files only. Click on Web to go back to searching for web pages.

Some search engines have a link to Options or Preferences to allow you to be more specific in your searches and select the type of results you want to receive.

The SafeSearch filtering option available on certain search engines is especially important as it enables you to filter out or to allow explicit text or images to appear in your results.

**Using Operators**

Most search engines allow you to use what are called Operators. These are query words that have special meaning to the search engine, such as AND.

For example, typing in *dog AND cat* forces the search engine to find pages that contain both the words dog and cat. More information about advanced search features can be found on this Live Search help page: [Advanced Search Options](http://www.easycomputertips.com).
Create And Backup Favorites

This guide explains how to create and backup your Favorites bookmarks.

It also shows how to arrange these links to your favourite web sites into folders.

What are Favorites?

When browsing the World Wide Web you will come across certain web sites which you might want to visit again. Instead of typing in the address each time, you can store a list of Favorites in Internet Explorer which require only a simple click to take you to a web site.

View Favorites

To view your current list of Favorites, in Internet Explorer 6 click on the Favorites menu at the top of your browser. In Internet Explorer 7 you can access your Favorites list by clicking on the Favorites Center button.

Add a Favorite Site

To add the current web site page to your list of Favorites, right-click somewhere on the page and select Add to Favorites from the menu that appears. Alternatively, in Internet Explorer 7 you can also click the Add to Favorites button at the top left of the screen.

A new window will open allowing you to give this Favorite a name to help you remember what the site was about. Type it into the Name box.

Use the Create In.. menu if you want to place this Favorite in a particular category on your Favorites list. If you want to create a new category, click the New Folder button and give it a name, for example ‘Shopping Web Sites’.

Click OK (or Add in Internet Explorer 7) and you should now have a new Favorite link in your Favorites list. Clicking once on this link will take you straight back to this page in future, without having to type the address in again.

Creating Folders For Groups Of Favorites

As your list of Favorites grows longer, you may find it useful to group together similar links in folders. When you click on the name of a folder in your Favorites list, it will expand to show all the links you have stored in that category.

Click the Favorites menu (in Internet Explorer 7 click the Add To Favorites button) and select Organize Favorites.
Click *Create Folder*. Give it a name then click *Close* and you should see a new folder in your list of Favorites. You can also *Delete* or *Rename* folders in this Organize Favorites window.

To move one of your existing Favorites into a folder, just click and drag the Favorite into the folder.

Folders, like individual Favorites, can be rearranged by clicking and dragging them up or down the list.

**Backing Up Your Favorites**

You can keep a backup of your Favorites in case you accidentally delete any of your list. You can also use this backup to transfer your Favorites list to a different PC or another browser program.

Click on the *File* menu (in Internet Explorer 7 click the *Add To Favorites* button) then click *Import and Export*. You should see a window welcoming you to the **Import and Export Wizard**. Click *Next*, then select *Export Favorites*. Leave the main folder selected on the Export Favorites Source Folder screen and click *Next*.

Make sure *Export to a File or Address* is selected, then *Browse* to a location on your hard drive where you wish to store a copy of your Favorites list. Type a name for your backup, for example *MyFavorites* and click *Save*. Click *Next*, then *Finish* and a window should tell you the export was successful.

The Favorites backup file is saved as a web page file and it can also be opened in your browser like a normal web page by double-clicking it. It will appear as a simple-looking web page containing your Favorites links.

**Importing Favorites**

To import a Favorites list, go back to the Import and Export Wizard. Choose *Import Favorites*, click *Next*, then make sure *Import from a File or Address* is selected. *Browse* to your saved Favorites file and click *Next*. On the Import Favorites Destination Folder screen, click *Next* then *Finish*.

You should see a message telling you your Favorites have been successfully imported from the backup file.

**Storing Your Favorites Online**

There are a number of web sites which allow you to store your bookmarks online, so you can access your favourite sites wherever you are:

- [Windows Live Favorites](#)
- [Yahoo! Bookmarks](#)
- [MyBookmarks](#)
- [Spurl](#)
- [Google Bookmarks](#)
Set Up A Hotmail E-mail Account

This article describes how to register a free Hotmail e-mail address and how to send and receive messages.

Sign Up For Hotmail

This article explains how to set up a free e-mail account through Hotmail.

Go to the Hotmail web site and click on the Sign-up button. From the choice of various Hotmail options, click the button by the Free version of MSN Hotmail.

You will now be taken to the Sign Up page.

To move between the boxes on the page either use the mouse and click in each box to start typing, or press the Tab key on your keyboard.

Choose Your Hotmail Address

Click to select your Country/Region from the drop down menu, and in the next box type what you would like your Hotmail E-mail address to be. You can use your first name or any words you like, but remember that most common words and names will already have been taken by other people.

So if your name is George, for example, you will need to choose something more complex than just george@hotmail.com. Try adding on a number such as your year of birth, for example george1884@hotmail.com, or add a phrase, for example georgeisreallycool@hotmail.com.

Click the Check Availability button to see if that e-mail address is available. If it is already taken, you will need to try different addresses until you find one that is available.

Choose A Password

Now choose a password you will remember, this must be different to your e-mail address or it will be too easy for other people to guess. The password should be at least six characters long and preferably should be a mixture of letters and numbers.
You will be able to see your password strength. This shows how difficult it would be for someone else to guess your password (obviously it is better to have a password that rates as ‘medium’ or preferably ‘strong’).

In the next box you will need to re-type your password to confirm it. Make a note of your e-mail address and password as you will need to use them to access your e-mail account in future.

Now click on the down arrow button to choose a question that you will be asked if you forget your password, for example the name of your first pet. Type in your answer to that question, which must be at least five characters long.

In the next box you can enter another e-mail address if you have one. This is in case you lose your Hotmail password and need it sent to you.

Continue down the page filling out your personal information in the appropriate areas such as your name, gender, and birth date.

**Confirmation**

You will then be asked to type the characters you can see in the picture. These characters are shown in a special way and if you type them in correctly, this confirms to Hotmail that you are a person and not a computer program that is signing up for lots of e-mail addresses automatically.

If you have any problems, click on the speaker button for an audio version of the characters, or click on the arrows button to request a new picture.

You now have to sign some agreements. You can read them if you wish or just click *I Accept*.

On the next page, click *Continue* and you will be given the option of receiving various e-mail newsletters, if you do not want any just scroll down the page and click the *Continue* button to go to your Hotmail account.

**Checking Your Messages**

Click on the *Mail* tab on the menu near the top of the page. The menu on the left shows the different folders you have:

- **Inbox** - all the messages you receive appear in here
- **Junk E-mail** - spam messages appear here
- **Drafts** - messages you are working on but have not yet sent go here
- **Sent Messages** - copies of messages already sent go here
- **Trash Can** - messages you have deleted go here to be removed permanently

You will probably already have one message in your Inbox, this is an automated welcome letter from Hotmail.
To open this or any other e-mail you receive, click on the name of the sender, in this case *Hotmail Staff*. You will now be able to read the contents of the e-mail message. To return to your Inbox click on the *Mail* tab on the top menu again.

If you want to delete a message and remove it from your account, place a tick in the box next to the particular message then click on the *Delete* option on the menu. This puts it in the Trash Can where it will soon be removed permanently.

If you receive an e-mail which you think is spam or junk mail, tick the box next to it and click on *Junk*. Click *OK* on the Report screen to report this message to Hotmail and remove it from your Inbox.

**Send A Message**

To create a new message to send to someone, click on *New*. Type in the e-mail address of the person you want to send the mail to in the *To:* box.

The *Cc:* and *Bcc:* boxes are used if you want to send a copy of your message to more than one person, otherwise leave these blank.

In the *Subject* box, type a title for your message, for example *Party Invitation*. You can now type your message into the *Message* box below.

Click *Send* from the menu to send your e-mail. You should see a message telling you the e-mail has been sent. Click *Return to Inbox*.

If you want to test how a message will look before sending the e-mail to anyone else, you can send the message to yourself by putting your own Hotmail address in the *To:* box. After you send the message, go to your Inbox and you should see your message. Open it by clicking on the sender name (in this case your name).

**Reply To A Message**

If you want to reply to an e-mail you are viewing, click *Reply* on the menu.

When you do this, you should find that the *To:* box is already filled out for you and the *Subject* box has the message title and the letters *RE:* which means this is a reply message.

In the message box itself is a copy of the message you are replying to. It is usually best to leave this here and start typing in the space above it. This means the recipient will be able to see their original message for reference, along with your response.

Click *Send* when you are ready to send your reply.
Attaching Files

Sometimes you will want to attach a file to send with your e-mail, such as a document or picture file.

Start a new message and fill out the boxes as before, but this time before sending it, click on Attach and choose File. Click on the Browse button and find the file on your computer.

When you have found your file, double-click it and you will see its location appear in the Find File box, now click OK to continue (or OK and Attach Another if you want to attach more than one file to this e-mail). The file will be checked and if all is well, you will be returned to your message.

You should now see a new section between the Subject box and the message box listing all the files you have attached to this e-mail. Click on Send on the menu when you are ready to send your message.

Depending on the type of Hotmail account you have, you may not be able to send very large files with your e-mail. To read about ways of making large files smaller, read E-mail Attachments.

You can tell if a message you have received has an attachment if it has a paperclip symbol by the side of it.

Signing Out

When you have finished working with your e-mail account, click the Sign Out logo at the very top of the screen.

It is especially important to remember to sign out if you are accessing your e-mail from a public computer or one you share with other people, because if you leave it without logging out the next user of the PC could have access to your account.

Signing In

When you want to sign in to your account in future, go to www.hotmail.com and enter your Hotmail e-mail address and password in the Sign-in box. Tick the box marked Always ask for my e-mail address and password if you are using a public computer. Click the Sign In button to go to your account.

You can change any of your Hotmail options from within your account by clicking on Options, and you can get more information and help with your account by clicking on Help.
Back Up E-mails In Outlook Express

This article describes how to back up your Outlook Express e-mail files and how to retrieve them later.

Introduction

It is important to make a backup copy of your e-mails regularly, as with all your important files. You can keep a copy of your files in another folder on your PC, or back up to a CD for extra peace of mind.

This guide shows you how to make a copy of the files Outlook Express uses to store your mail data, and then how to import this saved information back into Outlook Express later.

Find your Store Folder

First, you need to find the location on your PC where Outlook Express stores your files.

Start Outlook Express and on the menu click Tools then Options. Click on the Maintenance tab then the Store Folder button.

This shows you where your messages are stored. Right-click on the location text and choose Select All, then right-click on the text again and choose Copy.

Click Cancel, then Cancel again to close the Options windows. Now exit Outlook Express.

Click on your Start menu and then click Run. Right-click anywhere in the Open box and Paste the location you copied into the box. Click OK.
Back up your e-mail files

In the new window you can see the files Outlook Express uses to store your information.

From the menu at the top click Edit then Select All. The files in this folder should all now be highlighted. Click Edit again and this time choose Copy.

Now you need to find somewhere to keep your backups. In this example you will create a new folder in My Documents. For extra safety you may want to store your back up on a CD or another PC.

Open My Documents, click the File menu and choose New then Folder. Give this folder a name, such as 'email backup'.

Double-click this new folder to open it. Now click on the Edit menu at the top and then click Paste. This will copy your e-mail files from the Outlook Store folder into your new backup folder.

Restore your mail from a backup

You can retrieve mail you have saved in your backup and import it back into Outlook Express.

Start Outlook Express and from the menu select File then Import and choose Messages. Select the e-mail program that you backed up from (for example, if you used Microsoft Outlook Express 6, choose this from the list). Click Next.

Select Import mail from an OE6 store directory and click OK. Click the Browse button and find the backup folder you created (or the CD or other location where you have stored your backup). Click to highlight this folder then click OK. Click Next to proceed.

You can now select All folders (to import all the mail from the backup) or Selected folders (to restore only specific mailboxes). Click Next then Finish to complete the importing of your data.

If you see an error message such as 'No messages can be found in this folder', make sure the files you are trying to import are not read-only. This can happen if you are trying to restore mail from a CD-ROM.

You can check this by opening the folder or location of your backup files, selecting Edit from the menu at the top and then Select All. Now click File then Properties. Make sure the Read Only box is not checked and click OK. Now try restoring the backup files again.
E-mail Attachments

This guide explains how to attach files to messages you want to send by e-mail.

There are also tips on what to do with attachments you receive from other people.

What are Attachments?

When you send an e-mail it is possible to send other files along with it, such as images or documents. You 'attach' the file by selecting the file on your PC and then use your e-mail program to upload the file into your e-mail account, so it can be sent along with your message.

Sending Attachments

This example shows how to send a file to a friend along with a message describing it. The instructions are for Hotmail but it should be a similar process with most other e-mail programs or web services.

Log in to your e-mail account and click on New Message. Fill out the To: and Subject boxes and write your message. Now click on Attach and select File.

You now need to tell the computer where to find the file you want to attach. Click on the Browse button. When you find the file you want, click to select it then Open. Now either click OK to confirm, or click OK and Attach Another if you want to add more than one file.

Your file will now be uploaded (transferred) to the Hotmail server and should appear listed between the Subject and Message boxes under the list of Attachments. It also tells you how large the file is in MB (megabytes). With a free Hotmail account you can send up to 10 MB in one message, though the larger the file the longer it will take the recipient to download your attachment at their end.

You can now send the message as normal and the attachment file will be sent with it.

Making Large Files Smaller

Large files will take longer to send and receive. To check how large a file is before you send it, right-click the file on your computer and click Properties. Here you can see the file size. If the total of all the files you want to send is over 10 MB you will not be able to send them all at once in Hotmail.

There are several ways to reduce the size of pictures and other files.
Picture Files

Probably the most common type of file attachment is picture files. Normal picture files are called Bitmap files with the filename extension .bmp. These can take up a lot of file space, so to reduce this they are often compressed into smaller-sized filetypes which may lose a little quality, but are usually still good enough for most purposes. Most picture files on the Web or sent by e-mail are .jpeg or .gif files.

To convert an image to one of these compressed filetypes, right-click a picture file and choose to Open With.. and select Paint. Alternatively right-click the file and choose Edit to use your default graphics editing program.

In Paint, click File and Save As.. and in the Save As Type drop-down menu, select a filetype such as JPEG. Give the picture file a name then click Save and the picture will be converted to this filetype.

.jpeg file sizes can be many times smaller than typical .bmp files. If you right-click the new file you have saved and view Properties you should see a difference in file size compared to the original.

With pictures that are very tall and very wide, even .jpeg file sizes can be very large. The solution in this case is to resize the picture down to a reasonable size.

Open your original picture in Paint again and click on Image then Stretch/Skew. Now you can type in a percentage to stretch the file by. If you input a figure less than 100% you are actually squeezing rather than stretching, for example if you type 50% for horizontal and 50% for vertical then click OK, the picture will be squeezed to half of its original size.

This is a simple way of reducing a picture's physical size and therefore file size. Once you have squeezed the picture to the size you want, save it as a .jpeg as before and when you view the file's Properties again the file size should be much smaller.

Other Files

Other files such as Word documents (.doc files) will need to be compressed into .zip files with a program such as WinZip. Read Compress Files for more information.

However, not everyone will know how to open a .zip file. If they have Windows XP they should be able to open it by double-clicking it. If not, they may have to download a program like WinZip to actually open the file you have sent them.
Opening Attachments Safely

You should be very careful when opening any file attached to an e-mail. This is one of the most common ways for viruses to travel on the Internet and if you are not careful your PC may become infected. There are some simple rules to follow to keep yourself safe:

- Don't open any e-mail attachments you're not expecting especially if you don't recognise the sender's address
- Don't assume that because it's from a friend's address it will be safe
- Always download the file to your computer first then virus check it before opening it

Hotmail automatically scans all attachments for viruses although it is still possible some infected files will come through. When you click on an e-mail with an attachment, if it is a picture file it may automatically open and appear along with the message.

If you want to save any type of attached file on to your computer, click on the name of the attachment under the Subject heading at the top then click Download File.

If it is a picture file it may be opened in a new window, if so right-click the image and select Save Image As.. to save to your computer. For other types of files, after you click Download File, choose Save To Disk to save to your computer.

Once saved, you should scan the file with your virus checker before opening it.

Printing Image Attachments

If you want to print a picture file you have been sent, download it to your computer then right-click and open with Paint, adjust the height and width if necessary by using Stretch/Skew as described above and then click on File then Print. You can click Print Preview to get an idea of how it will look before you print it.

If you have been sent several images (such as a collection of holiday photos) you may want to put them all together to print on one page. One way of doing this is by opening Microsoft Word then clicking Insert then Picture From File. Do this for every picture you want to include and you should see them laid out on a page.

If you click on a picture in Word to select it, you can then click and drag the corner handles to stretch or squeeze the image, this way you will be able to adjust the pictures until they all fit on one page for printing.
Preventing Spam

This guide explains what Spam mail is and how to avoid receiving this type of junk mail.

What is Spam?

Spam is the term used to describe junk mail messages sent to your e-mail account.

You may receive an e-mail and not recognise the address of the sender. Alternatively, spam mails can come from people you know, but who are not aware their account is being used by a malicious program to automatically send out junk mail to contacts in their address book.

Someone may forward a spam e-mail to you thinking it is a genuine message - perhaps appearing to be from a charity asking for your help to spread their message to everyone you know.

Like junk mail that comes through your door, spam e-mails often try to encourage you to buy a product or sign up for a service. Often there will be an attached file or a link to a web site, but these may actually be trying to install malicious software on your PC or attempting to get your personal information.

How can I tell if a message is Spam?

Spam mails will usually try to entice you to open them by having titles that promise things like financial rewards, health products, the latest news or gossip, cheap deals or celebrity pictures. Often their titles will contain odd mis-spellings; these are attempts to fool anti-spam programs.

The safest course of action is not to open any e-mail you're not expecting, especially if it has an attached file, or if you do not recognise the name or address of the sender.

If you have opened an e-mail and are trying to determine if it is genuine, you could try copying the subject line or some of the message into a search engine. If other people have mentioned it on any web sites you should be able to find out if it is spam. You should always do a search on any company before you buy from them or send them any money.

What is Phishing?

Phishing is the process of sending out lots of fraudulent spam e-mails with the hope of tricking a few people into giving out their passwords or personal information.

Phishing messages may appear to be from a bank or other financial institution, asking you to confirm your account details by replying to their e-mail or by following a link to a web site.
When you arrive at the fake site, which can often look professional and genuine, you will be asked to type your details into a form and this is where your information will be captured by the criminals behind the phishing.

You may be able to tell if you are not actually on your bank's real web site by looking at the address of the site in your browser.

Remember, your bank will never ask for your passwords or personal information in this way, and if you are in any doubt you should always contact your bank before giving out your details.

**How did they get my e-mail address?**

It may be that the spammer has just made a lucky guess using software which automatically generates possible e-mail addresses.

If your e-mail address is fairly obvious it can be guessed easily. Try to use combinations of numbers and letters, and the longer or more obscure the address the harder it will be to guess.

When you register on a web site or sign up for things like newsletters and membership accounts you may actually be opening the door to receive e-mail marketing spam from these sites and their partners. Most trustworthy sites should give you the option of not receiving advertising mails when you sign up.

**What can I do to prevent Spam?**

Because it takes so many different forms, it's virtually impossible to block all spam from appearing in your e-mail account, but there are ways to avoid receiving a lot of it and even help in the fight against the spammers.

Your e-mail provider may have its own system which attempts to filter out a lot of the spam you might otherwise receive. They do this by automatically checking your e-mails for common spam messages, keywords or known spammers' addresses, then place any they find in a separate Spam/Junk/Bulk folder rather than your Inbox.

It is worth having a quick look through your Spam folder occasionally in case some legitimate e-mails have been falsely identified as spam by the system. There is usually an option to move the mail back to your Inbox, or even mark it as *Not Spam* to help the system identify e-mails that are safe to receive.

Some providers allow you to mark any junk mail you do receive in your Inbox as Spam to help prevent you getting it again and to stop others receiving it too.
How to protect your e-mail address

You may want to consider having more than one e-mail address: use one address whenever you sign up for anything on the Web, and give your other address only to people you know.

When you do get spam mail, never reply or click a link offering to remove you from their mailing list. This will only confirm your address is real and you will then get even more spam.

Never sign up for any spam e-mail opt-out lists, these are just another attempt to get your email address or money.

It is important that you have up-to-date anti-virus software. If a virus infects your PC it may try to use your address book to spread itself through e-mail spam to all your contacts.

Visit www.getsafeonline.org for more advice about spam prevention and security online.

Anti-Spam software

BopSpam
MailWasher
Spam Bully
BitDefender Internet Security
McAfee Internet Security Suite
Set Up Instant Messaging

This article describes how to install Windows Live Messenger to send and receive messages instantly.

Introduction

Instant Messaging allows you to chat in real-time with your friends and other contacts across the Internet.

It is similar to using e-mail, but much easier and you can get a response straight away, provided you are online at the same time as your contact.

Using a program called an **Instant Messenger**, you can see which of your contacts are currently online and begin a conversation with them.

Install Windows Live Messenger

**Windows Live Messenger** is Microsoft's new Instant Messaging software, replacing the popular MSN Messenger.

You can download it free from the Windows Live web site: [Download Messenger](#)

Click the *Get It Free* button. On the window that pops up, *Run* to begin installing as soon as the program has been downloaded. Click *Run* if you get a security warning.

You should now see the Setup Wizard window. Click *Next* and then click to accept the Terms of Use. Click *Next* to move on.

There are now options for several additional features. Leave *Windows Live Messenger Shortcuts* checked if you want shortcuts to the program on your desktop and taskbar. Uncheck the other three options (*Windows Live Sign-in Assistant, MSN Home* and *Windows Live Toolbar*) and click *Next*.

Windows Live Messenger will now be installed. Click *Close* when informed the install has been successful.

Logging In
A Messenger window should now appear, and you will also see a new icon on your taskbar.

In this new window you will be asked to enter your login information. This is your Windows Live ID (your MSN/Hotmail e-mail address and password).

If you don't have a Windows Live ID, click the link underneath for Get a new account. You will then be taken to a web site where you can sign up for a free account (see Set Up A Hotmail E-mail Account for more information).

Once you have entered your login details in the Messenger window, you can tick the options underneath if you are happy for Windows to remember your details and log you in automatically in the future. You should leave these options unchecked if you are using a public PC, or one that other people have access to.

Click Sign In to get started.

Using Messenger

You will now see the main Messenger window on the left, which includes your list of contacts, and a news window on the right.

If you don't want to see the news window every time you start Messenger, check the box under the right window that says Don't show this window when Windows Live Messenger starts.

To get started with Messenger, you have to add contacts by entering their e-mail addresses. Click the Add a Contact icon at the top, to the right of the Find a contact or number.. box.

If you are ever unsure what a particular icon on the screen represents, hold your mouse cursor over it without clicking to get more information.

In the Add a Contact window, you can enter details for the person you wish to communicate with. Type their e-mail address into the Instant Messaging box.

That is all you need to do to add a contact ready to start messaging. However, there are some other options for editing contact details that are worth knowing about.

Edit Contact Details
Below the Instant Messaging box where you entered the e-mail address, there is an option to *Type a personal invitation*. This allows you to send an e-mail to the person you want to contact with instructions to show them how to install Messenger.

You can enter a nickname for the person which will appear on your list of contacts, rather than their e-mail address, so you can easily see who is on your list. You can also assign them to a specific group such as Friends or Coworkers.

You can add as much information about your contact as you wish by clicking on one of the other menu tabs down the left of the window (*General*, *Contact*, *Personal*, *Work* and *Notes*).

Remember to click the *Save* button when finished adding a contact.

**Send A Message**

If your contact is online they will get a message that tells them you have added them to your contact list. The message also asks them if they want to receive messages from you or not.

To start a conversation with one of your contacts, find their name on your contact list. The list shows which of your contacts are currently Online and which are Offline. If a contact is marked as Online it means they are using the Internet and have their Instant Messaging software running and checking for messages.

If you send a message to someone who is Offline at the time, they will receive your message the next time they access the Internet.

Double-click on the name of one of your contacts to open a conversation window. The box at the top is a record of your conversation so far, and the box below is where you can type your messages.

Click in this box and begin typing like you would an e-mail message, though usually an instant message is shorter than an e-mail so conversations can be quick. You can use the menu icons just above the box to add emoticons, change font size, colour and more.

When finished, click the *Send* button or press the *Enter* key on your keyboard. Now wait for a response. If your contact is online they will get a pop-up message that tells them you want to start a conversation.

Under the message box on your conversation window you will see a notification if your contact is currently writing a reply to you. Their message will then appear in the top box, after the message you just sent. You can continue the conversation by writing your next reply in the message box, and clicking *Send* again.

When you want to finish a conversation, send a message to let your contact know and then click on *Close* in the top-right of the conversation window.

**Safety Tips**
Click the *Safety tips* icon on the left of the main window to get information about safe messaging, and the option to *Report Abuse*.

When sending messages across the Internet, you should be careful what content you send in your messages. Do not send personal information such as bank account details.

As with all chat software and social networking sites, there are dangers and it is important to help children stay safe online. For more information read *How To Keep Kids Safe On The Web*. 
Get The Most From The Web

An introduction to the many and varied ways you can take advantage of the World Wide Web - including shopping, education, family history, entertainment and careers.

Introduction

Shopping, banking, hobbies, dating, health, entertainment, education, careers, clubs, sports, holidays...virtually every aspect of our daily lives can benefit from the Internet in some way. Whatever you need to do, there is usually a way to use the World Wide Web to help you find the information you need.

What You Can Do Online

You can order your clothes, food and medicine online and have them delivered to your door. Need a plumber? Hairdresser? Use the Web to find local businesses and get directions to shops in your area.

Choose to manage your bank accounts through your web browser, make payments and pay bills. Buy CDs, DVDs, books and clothes without travelling to the shops, and read reviews and other customers’ opinions before you buy.

You could book your holiday online, take a virtual tour of a resort before you get there and compare prices to find the best deals. You can get road maps, travel guides and exchange rate information.

Get weather reports and read the latest news and sports results. Find advice and information about health issues and get first aid tips. Write an e-mail message to a friend, or send a photo you've just taken with your digital camera to a relative in another country.

Need to help the kids with their homework? All the information they need is on the Web, with pictures, sounds and games to get them interested.

Get Entertained

You can read electronic books, poetry and short stories online. Browse works of art or take a tour of a museum. And you no longer need a television to watch TV and films, or a stereo to listen to music or radio. You can do it all on your PC using the Web.

How about a game? You can find thousands of free games on the Internet, and you can play with other people too - from simple puzzle and card games to complex 3D worlds where you can take part in adventures with thousands of other players across the globe.
Get Educated

There are many ways to improve your knowledge using the Internet and open up new possibilities.

You could learn a different skill or a new language and get a qualification. Look for a new job and display your CV to potential employers. Work from home or start your own business, using the Web to promote yourself and to sell to customers across the world.

Get Social

Read information about your local area and get involved in your community. Find relatives you never knew you had and discover facts about your past by researching your family tree.

Find out about clubs and societies you could join. Arrange meetings and discuss topics in messageboards with people who share your interests. Make new friends in chatrooms or maybe meet someone special on an online dating site.

Get Creative

You can find tools to create your own music, games and movies. Design a web site to share your hobby or teach people using your knowledge. Write about your life or become a citizen reporter and use your blog to give the latest news from your area.

The Internet offers fantastic opportunities for everyone, but especially the elderly and those who are unable to leave their homes due to disability or other reasons. For some people it gives them a whole new lease of life.

Pick a search engine such as Google or Yahoo and type some words or a phrase into the search box. You may be surprised how many people share your interests and how much the Web has to offer.

Web Sites To Try

For a list of example web sites to try, read Things To Do On The Web
Things To Do On The Web

On this page are examples of the types of things you can do on the World Wide Web, with some web sites for you to try.

There are web site links for shopping, news, travel, music, sports, games and more:

- Buy and sell products online - Amazon, eBay
- Learn computer skills - BBC Webwise
- E-mail friends and relatives around the world - Hotmail, Yahoo! Mail
- Research your family history - Ancestry.com, Family Search
- Book holidays - Virgin Holidays
- Find cooking recipes - Delia Smith, Cooking.com
- Read the latest news - BBC News, CNN
- Get information about Sports teams and matches - BBC Sport, Sports Illustrated
- Book theatre tickets - Last Minute
- Find out cinema showtimes - Movie Watcher
- Listen to music from famous bands and unsigned artists - Download.com Music, iTunes
- Get information about health issues - BBC Health, NHS Direct
- Learn a language - BBC Languages, World Wide Learn
- Read about historic events - The History Channel, History World
- Get weather reports - Weather.com, BBC Weather
- Find businesses in your area - Google Local
- View maps of areas and get directions - Yahoo! Maps
- Play games with people around the world - GameSpy, MiniClip
- Listen to radio stations - Web-Radio, BBC Radio
- Watch TV programmes online - wwiTV, Beeline TV
- Watch movie trailers - Apple Trailers, Movie Insider
- Get gardening tips - BBC Gardening, About Gardening
- Get help with homework - BBC Schools, Homework High
- Meet new people and chat with interest groups - FaceParty, Match
- Write about your life, thoughts, hobbies and experiences - Blogger
- Go on virtual tours of museums and art galleries - Louvre, Oxford Virtual Tour

There are many other things you can do on the Web. You can use search engines such as Google or Yahoo to find web sites on whatever topics you are interested in. Have fun!
Links To Useful Web Sites

A list of links to web sites where you can find useful information and downloads.

Categories include shopping, sports, e-mail, music and games.

Blogging

- [www.blogger.com](http://www.blogger.com) - write a blog
- [www.spaces.live.com](http://www.spaces.live.com) - create your space

Computers

- [www.dell.com](http://www.dell.com) - Dell computers
- [www.download.com](http://www.download.com) - download software
- [www.tweakguides.com](http://www.tweakguides.com) - improve performance

E-Mail

- [www.hotmail.com](http://www.hotmail.com) - Hotmail
- [http://mail.yahoo.com](http://mail.yahoo.com) - Yahoo! Mail

Games

- [www.fileplanet.com](http://www.fileplanet.com) - game files
- [http://pcgameview.blogspot.com](http://pcgameview.blogspot.com) - PC games news
- [www.gameFAQs.com](http://www.gameFAQs.com) - game help

Graphics Cards and Drivers

- [www.nvidia.com](http://www.nvidia.com) - Nvidia graphics cards
- [www.ati.com](http://www.ati.com) - ATI graphics cards

Jobs

- [www.monster.com](http://www.monster.com) - search for jobs

Kids

- [www.bbc.co.uk/schools](http://www.bbc.co.uk/schools) - learning
- [www.channel4.com/learning](http://www.channel4.com/learning) - homework help
- [www.kidscom.com](http://www.kidscom.com) - fun activities
Media Players

- www.winamp.com - music and video player
- www.quicktime.com - Quicktime video player
- www.sourceforge.net - Media Player Classic

Movies

- www.imdb.com - movie database
- www.themovieinsider.com - movie news and previews
- www.apple.com/trailers - movie trailers

Music

- www.allmusic.com - music guide
- www.myspace.com - listen to bands
- www.mp3.com - download MP3s
- www.itunes.com - iTunes

News

- www.cnn.com - CNN
- www.bbc.co.uk/news - BBC

Photography

- www.flickr.com - photo sharing
- www.istockphoto.com - stock images

Reference

- www.about.com - general info and articles
- www.wikipedia.org - web encyclopedia

Search Engines

- www.live.com - Live Search
- www.yahoo.com - Yahoo
- www.google.com - Google

Shopping

- www.amazon.com - buy books, music and more
- www.which.net - Which guides
- www.ebay.com - buy and sell items
- www.play.com - buy DVDs
Sound Cards and Drivers

- www.creative.com - Creative sound cards

Sport

- www.sky.com/sports - Sky Sports
- http://news.bbc.co.uk/sport - BBC Sport

Web Browsers

- www.mozilla.org - Firefox
- www.opera.com - Opera

Web Design

- www.w3schools.com - tutorials
- www.sitepoint.com - articles and forums
- www.alistapart.com - design tips

Web Hosting

- www.oneandone.com - web hosting

Windows

- www.windowsupdate.com - update Windows
Web Site Gallery

A pictorial selection of interesting and useful web sites.

Topics include family history, shopping, blogs, photography, movies and computer tips.

You can find more sites in the **Useful Web Sites** section at: www.easycomputertips.com/forum

**Podcast Alley**
(listen to podcasts)

**Ancestry**
(research family history)

**MailBigFile**
(send large files to friends)

**Apple**
(watch movie trailers)

**Shopping**
(shop for items, compare prices)

**TweakGuides**
(games and system performance tips)
FreebieList
(free tools, free samples)

Wikipedia
(encyclopedia, reference, articles)

UpMyStreet
(local information, find businesses)

Blogger
(write a blog, share news)

Lycos iQ
(ask questions, share knowledge)

About
(advice, solutions, computer tutorials)

HowStuffWorks
.general knowledge, explanations

Flickr
(photo upload, sharing)
Create A Blog

This article explains how to start your own blog to write about your thoughts and experiences.

What Is A Blog?

The word ‘blog’ is short for weblog - a personal web page where you can write about anything you want: your daily life, your experiences, music you like, your opinions on world events...anything.

Blogs have enabled millions of people to have their voices heard, to report on news from their country without media bias or government censorship, and to post political views that might otherwise remain unheard.

In this tutorial we will use the popular and easy-to-use service Blogger to create a simple blog.

How To Get Started

Blogger is owned by Google and has a straightforward interface to make creating your blog as quick and easy as possible.

To get started, go to the web site at www.blogger.com.

On the main page you will notice a list that constantly updates with the names of blogs that have had new ‘posts’, or entries, along with a Search box to search blogs from across the web.

You may want to have a look at a few blogs to get an idea of the kinds of things people write about, and how your own blog might look.

To get started making your own blog, click on the Create Your Blog Now button.
Create An Account

The first step requires you to create an account with Google, which can be used on other Google services as well as Blogger.

Fill in the boxes by entering your e-mail and choosing a password. You will also need to choose a Display name - this is the name that will appear by your blog entries.

Now type the characters you see in the image, which verifies you are a real person and not some automatic sign-up program. Check the box to accept the Terms of Service and click the Continue button.

Name Your Blog

Now you need to choose a title for your blog. Choose something that is unique and reflects the subject of your blog, rather than just 'my blog'.

Next choose the web address (URL) of your blog. You will probably want a similar phrase here as your title - type lowercase and without any spaces. Most common addresses will have already been taken by other bloggers. You can check if the address is available by clicking the Check Availability link.

The full address will look something like ‘http://[yourblogname].blogspot.com’. This is the location of your blog on the World Wide Web. You can give this address to your friends who can type it into their browser address bar as with any other web site address, to go straight to your page.

The final option on this page, Advanced Blog Setup, is only for users who want to store their blog pages on another web site away from Blogger.com. Continue to the next step.

Choose A Template

To get you started as quickly as possible, Blogger offers various templates which give you a set look and layout for your blog.

Later if you wish you can choose a different template or even design your own. For now, select a template you like by clicking on it. You can get a preview of what the page will look like by clicking on the preview template link. Click Continue when you have chosen a template.

Blogger will now create your blog. You are now able to start writing entries, create your profile or customise the look of your page. Click Start Posting to begin.
Create A Post

You will see four menu tabs at the top of the page: Posting, Settings, Template and View Blog.

Under the Posting tab you can manage your blog entries. You can create a new post or make changes to existing entries.

The entry box for posts is similar to the message box you see when composing an e-mail message. You can type a title then write your post in the box, using the menu options to change font size and colours, or to add a web site link.

You can also add an image to your post. Click the Add Image icon and use the Browse box to find the picture on your computer. You can choose whether the image is to the left, center or right of your text, and the Image size. When ready, click Upload Image then Done.

When you have finished writing your first entry, click on the Publish button.

You should now see a message telling you that your blog has published successfully. Click the View Blog link to see what your blog looks like with your first post. Click the Back button of your browser to return to the Posting section.

Edit Posts

If you need to make any changes to a post, click on Edit Posts from the menu. Click the Edit button next to the post you wish to change. When you have finished making changes, you must remember to click Publish to accept them.

Settings

Click on the Settings menu tab. There are a number of options for changing how your blog looks and works. Here are a few of the options you may want to edit:

Click on the Basic option from the top menu and you can enter a description explaining what your blog is about. This will appear near the title on your page.

You can choose other options including whether you want your blog to be listed when people search Blogger.com. You can also Delete This Blog if you no longer want your blog.

Click on the Formatting option on the menu. You can choose the number of posts or how many days' worth of posts you want to show on your main page.

The more full posts your main page displays, the longer it will take to load. Any posts you choose not to display here will still exist, as each post also has its own separate page which can be accessed via a link on the main page.
You should now change the date and time options to match your country and timezone.

Click on Comments on the menu. Here you can set options affecting the comments that people may choose to leave on your page after reading your post.

The Permissions section on the menu allows you to choose who is allowed to view your blog, and whether anyone else is allowed to add posts.

**Template Options**

Click on the Template menu tab. Here you have the ability to click and drag page elements and rearrange the layout of your blog design. Click on Fonts and Colors to set individual colours for different areas and sections of text.

You can also Pick New Template, or if you know how to edit web page code (HTML) you can make complex changes to your existing template or even create a new one.

Remember to click Save when finished making changes to your template.

**View Your Blog**

Click on the View Blog menu tab at any time to view your blog. Newer posts appear at the top of the page.

The side menus on your page will usually have links to previous entries and archives of all your posts, as well as your blog description and a link to your profile.

Click the Customize link in the top-right, or the Back button of your browser to return to editing your blog.

**The Dashboard**

The Blogger control panel page is called the Dashboard. Click the Dashboard link in the top-right of the editing pages to access it. From here you can see a list of the blogs you have created, and create new blogs.

On the right-hand menu you can Edit or View your Profile. Here you can add a photo and let visitors see more details about yourself, such as your job or your favourite movies.

When you have finished editing your blog click the Sign Out link at the top-right of the page.

**Return To Your Blog**

Whenever you want to log in to your account in the future to add new posts, go to www.blogger.com and sign in at the top-right of the page. Enter your username (or e-mail address) and password to log in.
Other Blogging Information

Blogger.com is just one of many web sites allowing you to share your thoughts and ideas with others online. Some services even allow you to share photos, videos and music. Examples include Live Spaces and MySpace.

You can also create your blog by making your own web site or using software such as WordPress.

There are other types of blogs becoming more popular such as vlogs (video blogs) and photoblogs.

To find blogs you can use search engines such as Technorati and Blogdigger.

Many blog users also use RSS feeds to get the latest posts delivered to their PCs rather than having to visit all their favourite blogs every day to check for updates.
Create Your Own Web Site

A guide to things you need to know about making your own web site.

What Do I Need To Make My Own Web Site?

For beginners, the easiest place to start is with commercial web design software, the most popular of which is Dreamweaver. This software allows you to easily layout your web site and insert text, images and other content.

There are templates and instructions to help you build your first web site pages, and there are also many advanced features to get to grips with as your skills grow.

To really understand what goes into creating your pages and get total control over them, you will need to learn a programming language called HTML (Hypertext Markup Language). This is a set of instructions to your web browser to tell it what text and graphics content to display on your pages.

Although you can use software like Dreamweaver to code HTML, it is possible to create HTML web pages using a text editor such as Notepad++.

HTML (Hypertext Markup Language)

HTML is a relatively easy programming language to learn as it uses many simple and obvious words as instructions. For example, the following is a line of HTML code:

```html
<font face="Arial" size="2" color="blue">This is blue Arial text in size 2</font>
```

This line displays some text which is in the Arial font at size 2 and in the colour blue.

Despite its relative simplicity, there is a lot to learn about HTML and all the different instructions that are available. Fortunately, there are many books and web sites that offer tutorials for beginners to HTML and web design.

XHTML (Extensible HyperText Markup Language) is a newer version of HTML that is cleaner, stricter and more future-proof. Modern web site design tends to use XHTML for content along with CSS (Cascading Style Sheets) for layout.

One of the best resources for learning web programming languages such as HTML or XHTML is www.w3schools.com

One thing many web coders find useful is to examine the code that makes up other people's web sites. You can do this by going to a site in your browser and on the menu, click View (or Page in Internet Explorer 7) and then click Source.
CSS (Cascading Style Sheets)

A good practice when creating web sites is to separate content and layout, so that you have a HTML or XHTML file for your page content (such as text), and a separate file called a ‘Style Sheet’ to handle the visual layout of your page.

CSS (Cascading Style Sheets) files contain instructions telling the browser how to display and arrange specific elements of the content. This is an example of CSS code:

```
p {
  color: blue;
  font-family: Arial;
  text-align: left;
}
```

The above piece of code tells the browser that all paragraphs (‘p’) of text should be coloured blue and use the Arial font. It also tells the browser that paragraphed text should be aligned to the left of the page.

Using CSS can help reduce the amount of code you need to write. Using the example above, you only have to specify settings for paragraphs once in the CSS file and it will affect every paragraph in the HTML page. Without a Style Sheet you would have to use HTML code to tell each individual paragraph to be blue, Arial, aligned left etc.

To learn how to use CSS code, read the tutorials at www.w3schools.com

Why Does My Site Look Different on Different PCs?

There are several reasons why web pages can look different on different PCs. One factor is screen display settings, such as screen resolutions and colours, which can vary on different monitors and LCD screens.

Many web sites use ‘fixed-width’ designs so that no matter what a particular PC’s display settings are, the web pages will always be a certain width, for example 800 pixels.

Other sites use ‘liquid layouts’, specifying percentages so that an overall width of 100% will stretch the page to fit the whole of the browser window. However, images and certain other parts of the content will not stretch, so sometimes this can lead to large gaps in the page design, especially on larger screens.

Different web browsers such as Internet Explorer and Firefox use different ways of displaying the same web page code. Mobiles and hand-held devices will also give a very different version of web pages. And some browsers only read text and do not display graphics or images at all.

In order to combat this problem, a set of ‘Web Standards’ was devised to try and make web sites look and act the same (or at least degrade gracefully) whatever the method of viewing them. To check that your web page code complies with Web Standards you can use the Validator tools at http://validator.w3.org
Domain Names And Web Space

Your web site will need a **Domain Name**, also known as a ‘web address’ or ‘URL’. There are many places on the Internet where you can buy one for your site.

Once you have decided on a suitable address to match your web site subject, such as `www.mysitename.com`, you will need to have that name registered to you.

There are various domain registration companies, such as [1 and 1 Internet](https://www.1and1.co.uk). You pay a fee after which the domain name is registered to you for a certain period of time.

Since many domain names have already been taken, you may not always be able to have your first choice name so you may have to think up some variation. Try to keep it short and unique so people will easily remember it.

You will also need some **Web Space** to store the files that make up your site. The web space is not on your computer; you need to buy it from a **Web Hosting** company.

What you have to do is transfer or ‘upload’ your pages to a specific storage area you have been allocated on a ‘server’ owned by your web host. This is a special computer that is always online, so that no matter where in the world your visitors are or what time of day it is, they can access your web site pages.

Your web host should give more information on their web site and provide tools for uploading your pages. There are also useful programs such as [Coffee Cup Free FTP](https://www.coffeecup.com/freeftp) available to download on the Web that can make the process easier.

Getting Listed With Search Engines

If you want people to visit your site, they need to be able to find it using a search engine. You need to choose a good domain name, use the right keywords on your pages, and put a clear title on each page reflecting its particular subject. There are many other methods you can use to try to improve your ‘search engine ranking’ (how near the top of search results pages your site appears).

Search Engine Optimisation, or SEO, is a big topic and one that is especially important to business web sites. There are many web sites and programs that attempt to boost search rankings artificially. For information about the right ways to increase your ranking and site ‘traffic’ (visitors), read [Google webmaster guidelines](https://developers.google.com/webmasters).  

How Can I Find Out How Many People Have Visited My Site?

Most web hosts will provide you with detailed statistics of not only the number of visitors to your site, but also information such as when they visited, which pages they viewed, how they arrived at your site and more.

Typically you will need to log in to your account page on your host’s web site and you will see options to display your statistics. Otherwise try [www.google.com/analytics](https://www.google.com/analytics).
Making Web Sites - 30 Useful Tools

Creating Web pages

- **Dreamweaver** - the popular web site creation package (Buy)
- **Hotscripts.com** - free scripts to use in your site (Free)
- **HTML Kit** - tools for coding web pages (Free)
- **AutoReplace** - easily replace text across multiple web pages (Free)
- **Namo web editor** - tools for creating web sites (Buy)
- **Notepad ++** - improved version of Notepad (Free)
- **Serif WebPlus** - web page creation software (Buy)

Designing graphics

- **Photoshop** - popular image editing software (Buy)
- **CoolText.com** - online logo graphics generator (Free)
- **IrfanView** - image editing software (Free)
- **Pixie** - show values for any colour on screen (Free)
- **Serif DrawPlus** - graphics editing software (Buy)

Managing your site

- **Contribute** - easily update sites and blogs (Buy)
- **Browser Resolution Checker** - test your site at different resolutions (Free)
- **CoffeeCupFreeFTP** - manage and upload your site files (Free)
- **Email check** - check if spammers can see your site email addresses (Free)
- **Firefox Web Developer extensions** - tools for development of sites (Free)
- **FileZilla** - manage and upload your site files (Free)
- **Link popularity** - see how popular your site is with search engines (Free)
- **Lynx browser** - check how your site appears in a text browser (Free)
- **W3C Validator** - validate your page coding against Web standards (Free)

Flash animation

- **Flash Professional** – premier Flash authoring software (Buy)
- **SWiSH Max** - Flash creation tool (Buy)
- **Ad Desk** - easily create Flash sites using templates (Buy)
- **DVIO** - captures video from digital camera to AVI (Free)
- **KoolMoves** - easily create Flash animation (Buy)
- **Turbine Encoder** – convert video to streaming Flash (Free)

Other features

- **MSN SiteSearch** - add a search facility to your site (Free)
- **PHPBB** – PHP-based system for creating forums (Free)
- **XSPF Music Player** - play mp3s on your web site (Free)
5 Steps To Keep Your PC Safe Online

There are some simple steps you can take to ensure your PC remains protected while you surf the Web.

Following these tips can help protect your PC from virus, spyware and other online threats.

1. Update Windows

Microsoft regularly releases free downloads to fix security problems with Windows, Internet Explorer and other Microsoft software such as Office. Read Update Windows to find out how you can get these important updates.

2. Install A Firewall

A good firewall such as ZoneAlarm will prevent programs from accessing the Internet without your permission, and block access to your PC from intruders. Read Install ZoneAlarm Firewall to find out how to install and set up a firewall.

3. Check For Viruses

Malicious virus code can infect your PC’s system files and damage your important data. Read Check For Viruses which explains how to use an anti-virus program to find and remove malicious programs.

4. Remove Spyware

Spyware is malicious code that tracks your movements on the Internet and can even affect your PC's performance. Read Remove Spyware which explains how to get rid of malicious spyware and adware.

5. Browse More Safely

The latest web browsers such as Internet Explorer 7 and Firefox 2 offer security features like pop-up blockers and phishing filters to keep you safe when visiting web sites. Read Start Using Internet Explorer 7 or Browse The Web With Firefox to learn how to install and use these browsers.
Update Windows

Microsoft regularly releases free downloads that help fix security problems with Windows, Internet Explorer and other software including Office. This guide explains how you can get these important updates.

What is Windows Update?

The Windows Update service provides a way of checking whether your Windows operating system needs any updates.

This can include security fixes, and software and hardware updates.

It is essential Windows is kept up-to-date to prevent malicious programs taking advantage of security flaws to harm your PC.

You can download and install updates by visiting the Microsoft web site, or set your PC to automatically download the files in the background while you work.

Note that ‘updating’ is not the same as ‘upgrading’. To upgrade your version of Windows from an older version to XP you would need to buy a Windows XP Home Edition Upgrade package. Updating Windows only ensures that you have the latest files for your particular Windows version such as XP.

Downloading updates from the Windows Update web site

Some of the steps below may require you to restart your computer so you may wish to print out a copy of these instructions before you begin. You should also save any work in other windows before continuing.

Note that you will need to use Internet Explorer to visit the Windows Update web site rather than other browsers such as Mozilla Firefox.

Go to the Windows Update web site. When you arrive at the site, you may see a message that your browser is checking for the latest version of the Windows Update software. This is the software that determines if your system needs any updates at this time. If you see a Security Warning box appear asking if you wish to install and run Windows Update, click Yes.
You will be asked to choose between **Express** (essential updates) or **Custom** (optional updates for other programs). Most users should click the **Express** button.

The Windows Update software will now check which updates you already have and which you need.

If after the scan you see the message 'No high-priority updates for your computer are available' this means the most important updates including security fixes for Windows are already installed on your system and you can leave Windows Update for now.

### Installing Updates

If you require any high-priority updates, the Windows Update program automatically selects all critical updates to be installed. Click **Install Updates**.

Your updates will now be downloaded and installed, note that this may take several minutes or longer depending on your Internet connection and how many updates you need to install.

Once this is complete, you will be asked if you want to restart your computer now. Make sure you have saved your work in any other windows you have open, then click **Yes** and your computer will restart.

You should check the Windows Update web site once a month for any new updates.

### Automatic Updates

Another way to get Windows updates is to have the files downloaded automatically to your computer using **Automatic Updates**.

The advantage of this is you can let Windows download updates in the background while you work, so you do not need to worry about updating manually.

A disadvantage of Automatic Updates is that it may use up some of your Internet bandwidth to download updates, which might be a problem if you are in the process of downloading a large file or playing an online game at the time and need the best speed possible. You can avoid this problem by setting a particular time for updates to be downloaded.

To turn on Automatic Updates, click on your **Start menu**, go to **Control Panel** and double-click **Automatic Updates**. Here you can choose whether to get updates automatically, set which times to download updates, and if you want to be notified before updates are downloaded or installed.
Install ZoneAlarm Firewall

Installing a good Firewall such as ZoneAlarm is essential to protect your PC online and prevent programs from accessing the Internet without your permission.

What is ZoneAlarm?

When you connect to the Internet, your PC opens itself up to the outside world. This enables you to view web sites, send e-mails and download files, but it also means you may be vulnerable to attacks from hackers or malicious programs.

Firewall security programs like ZoneAlarm make your PC invisible to other computers unless you specifically agree to allow a connection to be made. If a program on your computer tries to access the Internet, then ZoneAlarm will automatically warn you and enable you to decide if you want to allow or refuse access.

Getting Started

The steps below will require you to restart your computer so you may wish to print out a copy of these instructions before you begin. You should also save any work in other windows before continuing.

Go to this web site: ZoneLabs and click Download FREE ZoneAlarm.

Save this setup file to your computer. Double-click the file to open it and begin the installation process.

Installing ZoneAlarm Free

On the Installation screen, click Next and then enter your name. Leave the e-mail address box empty and untick the boxes about registering and receiving updates. Click Next.

Tick the box to agree to the Licence Agreement and click Install. Wait while the files are installed, afterwards there will be some optional survey questions. Just click Finish to proceed. When asked, click Yes to start ZoneAlarm now.

The License Wizard window will now appear. Click to choose the Free ZoneAlarm and click Next then Finish.

The Configuration Wizard now appears. Click Next and ZoneAlarm will present you with the option of configuring your Internet access to allow your default web browser to surf the Web. Click Yes and then Next. Click Done to exit the Wizard.
ZoneAlarm will now tell you it needs to restart your computer. Click OK. After your PC has been restarted, a window will appear asking if you want to learn about other ZoneAlarm products. Click No, Thank You. If you want to you can now watch a video tutorial, or just click Finish.

You should see a red and yellow ZoneAlarm icon appear on your taskbar, which lets you know ZoneAlarm is up and running.

You should also see the main ZoneAlarm configuration window. Click the Alerts and Logs tab on the left menu and put Alert Events Shown to Off, so that you will only receive a notification if a program attempts to connect to the Internet.

Setting Up Program Permissions

You can change which programs are allowed to access the Internet in the ZoneAlarm configuration window. Click the Program Control tab on the left menu, then the Programs tab at the top-right to see a list of the programs on your computer and what access settings ZoneAlarm currently has for them. Click to change the permissions for each program to Allow, Block or Ask.

However, another much simpler way to set up ZoneAlarm's program permissions is to wait until a particular program tries to connect to the Internet, at which point ZoneAlarm will pop up a window like this one:

This ZoneAlarm Alert window tells you which program is trying to access the Internet. You can choose either Yes or No to allow or deny access for this program.
Click Yes only if you recognise the program and are happy to allow it to access the Internet, for example Internet Explorer or Outlook Express.

If you are unsure whether to allow the program access, you may want to try typing the name of the application (in the image above, IEXPLORE.EXE) into a search engine to find out more about the program.

If you want your answer now to always apply to this program, tick the box marked Remember this answer the next time I use this program. Otherwise if you don't tick this box, the next time the program tries to use the Internet you will receive another pop up alert like this one.

Sometimes if you deny access for a particular program, you may find that certain other applications don't work properly. For example, if you stop a game from connecting to the Internet you won't be able to play online until you give it permission to connect in ZoneAlarm.

**More Features**

If you think you are being attacked by a hacker, you can stop all Internet access from your PC by right-clicking the taskbar icon and choosing Stop all internet activity, or alternatively by clicking on the STOP button on the main window. When you want to allow access, just click the button again.

You don't have to have ZoneAlarm's main window up all the time. Click the Close (X) button in the top right of the window and on the Shutdown pop-up window tick Don't show this message again then click OK. ZoneAlarm will now minimise to the taskbar.

This does not stop ZoneAlarm running, it simply hides the main window away from the desktop. If you want to see the main window again, right-click the taskbar icon and click Restore ZoneAlarm Control Center.

To close ZoneAlarm altogether and stop it running, you will need to right-click the taskbar icon and select Shutdown ZoneAlarm, then Yes.

By default, ZoneAlarm will automatically appear every time you start your PC and will also check the Internet for new updates from time to time.

The free version of ZoneAlarm offers good protection but does not have some of the more advanced security features of the commercial Pro version, such as anti-virus and tools to combat spyware and phishing.
Check For Viruses

Malicious virus code can infect your files and cause you to lose important data. This guide explains how to install an anti-virus program to protect your PC.

What Are Viruses?

Computer viruses are malicious programs designed to cause annoyance and even damage to computer data. They spread by infecting files and by automatically sending e-mails to everyone in your address book.

There are new virus threats everyday. It is essential to take steps to protect your PC.

What Can I Do About Them?

If you suspect you already have a virus on your computer, or if you just want to keep your computer safe from the threat of viruses, there are several virus-detection programs which will scan your system and let you know if any malicious programs have been found.

There are many commercial and free anti-virus programs available on the Web, all with different features and levels of security. This tutorial uses AVG Anti-Virus.

Download AVG Anti-Virus Free Edition

AVG Anti-Virus can be downloaded from the AVG website.

Scroll down the page and click Download Free Version. Under the Windows section, click the link to download the file under AVG Free for Windows installation files. Click OK to save the file to your PC.

Install And Run AVG Anti-Virus

Double-click the file you downloaded, and click Next on the welcome screen. Click Accept to agree to the License Agreement. Choose Standard Installation then click Next.

The Confirmation screen will now appear with your User Name and License Number. Click Next to proceed. Click Finish to begin installation.

After installation is complete, click OK. The main AVG Control Center will now start. On the First Run screen that pops up, click Next. Click Check For Updates and then Internet which will download any necessary files to bring your AVG up to the latest version.
A window will now pop-up if there are any available updates. Click *Update* to download them. AVG will download and automatically install any updates. Click *OK* when finished.

Back on the First Run window, click *Next* to proceed. Leave the Daily Scanning settings as they are and click *Next*.

You now have the option to perform a scan to test your computer for viruses. Click *Scan computer!* or just click *Next* if you want to proceed with setting up AVG.

If you wish, you can now register your copy of AVG to receive news and product information. Otherwise, click *Next* and then *Continue*.

**AVG Test Center**

You can now see the AVG **Test Center** window. Here you can see your Security Status, and choose to perform scans on your whole computer or selected areas only.

When you run a complete scan, it may take a while depending on the size of your hard drive. It will scan your system for any viruses and if it finds any, it will pop up a window to inform you what action it has taken.

If possible the program will try to 'heal' any infected files, or if it is unable to clean these files it may move them to its **Virus Vault**, where the infected files are kept in a state where they will not be able to harm your computer, but can be retrieved later if necessary.

The AVG Anti-Virus program contains several tools which continuously monitor your system, but it is recommended that you run a complete scan of your computer regularly, at least once a month to check your computer for any infected files.

If you do not want to run a scan now, just click the *Close (X)* button at the top-right of the AVG window. This does not in fact stop the AVG program running, it just closes the windows so you can get on with using your PC.

**Using The AVG Icon**

You can tell if AVG is running as a small coloured icon will be displayed on your taskbar.

If you right-click the AVG taskbar icon you can restore the Control Center and Test Center windows. You can also perform a manual *Check For Updates* from this menu.

AVG will quietly monitor your PC and check for viruses while you continue using your PC. It will start automatically when you first turn on your PC and check for any updates when you connect to the Internet.

If you need to stop AVG running for any reason, right-click the taskbar icon and choose *Quit AVG Control Center*. To start AVG, click the *Start menu* then *All Programs*. Click *AVG Free Edition* and choose *AVG Control Center*. 
Remove Spyware

Spyware tracks your movements on the Web and can affect your PC’s performance. This guide explains how to protect your PC and remove spyware.

What Is Spyware?

Spyware is malicious code that infects your PC and can manifest itself as things such as unwanted browser toolbars and pop-ups, or if your browser homepage suddenly changes without your knowledge.

Spyware also takes the form of tracking files that watch where you go on the web in order to create a marketing profile of you that will be sold to advertisement companies. Not only is it a source of irritation but it also infringes on your privacy too.

Removing spyware is an important step in the process of cleaning unwanted files and programs from your PC, keeping it secure and fixing problems.

Fortunately there are programs available to help you track down and remove these unwanted files. There are several commercial security packages that offer anti-spyware tools as well as other features.

Ad-Aware and Spybot are two free programs you can use to fight spyware.

Installing Ad-Aware

Download Ad-Aware SE Personal from the Lavansoft web site.

Click on the link to the Free Download of Ad-Aware SE Personal.

You may be taken to another web site (such as Download.com) where you can download the Ad-Aware installation file. Click Download Now and save the file to your hard disk.

Double-click the file you downloaded and the installation process will begin. Click Next to progress through the various windows. Tick the box to accept the license agreement.

You can leave the Destination Folder as it is shown. If asked, choose to install for Anyone who uses this computer.

Wait while the program files are installed. Un-tick all of the three options Perform a full system scan now, Update definition file now and Open help file now - then click Finish.
Using Ad-Aware

You should see a shortcut to Ad-Aware SE Personal on your Desktop, alternatively you can find the program listed in your Start menu > All Programs list under Lavasoft Ad-Aware SE Personal.

Start the program and you will see a message stating your definitions are out of date and asking if you wish to update - click OK. You will see a window appear entitled 'Performing Webupdate', click Connect and Ad-Aware will check for any updates.

You will see a message telling you 'New definitions file available'. Click OK to download this update. When the download is complete click Finish.

Now you can see the main Ad-Aware SE Status window. Click the Start button and choose either the Perform smart system scan to check only particular vulnerable areas or Perform full system scan to check all files on the hard drive, and click Next.

A full system scan may take a while and you should not perform any other tasks on your PC until it is finished. When the scan is finished, the summary will tell you how many threats were identified.

Click Next to see information about these objects and put a tick by each one you want to remove. If you wish to remove all of the items, right-click one of the empty boxes and Select all objects. Click Next, then OK to confirm you want to delete.

In the majority of cases these files can be removed without causing problems, but you should be aware that occasionally certain spyware files come with programs you have installed such as games, and there is a possibility that these programs may not function correctly if you remove the files.

That is all you need to do to perform a straightforward check to remove spyware from your system with Ad-Aware, but the program does have other features too. Click the Help button if you want to find out more.

Installing Spybot

Download Spybot Search & Destroy for free from the Spybot web site.

Click the Download link on the menu, scroll down to the Download section and click on Spybot - Search & Destroy. Choose one of the mirror web sites that contain the installation file by clicking Download here to go to that site.

On the file mirror web site, download the Spybot file and save to your hard disk..

Double-click the file you downloaded and the installation process will begin. Choose your language and click Next or OK to progress through the windows. Tick to accept the license agreement. You can leave the Destination Folder as shown.
Choose *Custom installation* and leave only the *Main Files* option ticked. When asked about selecting a Start Menu folder, just click *Next*. You will see a window about selecting Additional Tasks for the installer to perform. Click *Next* then *Install*.

After the program files are installed, un-tick the option to *Run SpybotSD.exe* and click *Finish*.

**Using Spybot**

There should be a shortcut to Spybot on your Desktop, alternatively you can find the program listed in your *Start menu > All Programs* list under *Spybot - Search and Destroy*.

Start the program, and you may see a notice about advertisement robots. Tick *Don’t show this message again* and click *OK*.

You will now see a Wizard window appear. Just click *Next* to go through these Wizard screens and then click *Start Using The Program*.

On the main Spybot window click the *Search for Updates* button. You should see a list of available updates, right-click any of the boxes and click *Select all* then click on the *Download Updates* option at the top of the screen. Spybot will now download and install the latest updates to its files.

Now click *Check for problems*. Spybot will begin scanning your PC for known spyware files.

Once the scan is complete you will see a list of any detected problems. Select or deselect particular objects by ticking or un-ticking their boxes. You can also expand the entries to see more details.

If you use Firewall and Anti-virus programs such as *ZoneAlarm* and *AVG* rather than those built-in to Windows, you may see warnings that the Windows Firewall and AntiVirus are disabled. Just un-tick these entries.

Click *Fix Selected Problems*, then click *Yes* to confirm removal. Click *OK* when the problems have been fixed.

Spybot also has a *Recovery* option to undo any changes if you find problems with other programs after removing certain spyware files.

**How Often Should Scans Be Run**

Because there are so many new spyware threats appearing all the time, you should try to run Ad-Aware and Spybot scans regularly, at least once a month.

Remember to check for updates to the programs before you run a scan. This insures the programs are aware of the latest threats and will be able to detect and remove them.
How To Keep Kids Safe On The Web

This article features advice for helping kids stay safe while they browse the Web.

The World Wide Web provides a wonderful resource for entertaining and educating children. However, dangers do exist and it is important for kids and parents to be aware of these dangers and to know how to stay safe online.

This article features practical advice for both kids and parents.

Advice for Kids

The Internet is full of interesting web sites and is a great way to meet new friends across the world who share your interests. Unfortunately, not everyone you meet on the World Wide Web is friendly and some people even pretend to be someone they're not.

To make sure you have a safe time while you're surfing the Web, remember these tips:

- Avoid giving out your e-mail address to people you don't know
- Never give out your full name, telephone number, home address or the name of your school
- Don’t open e-mails or attachments from people you don't know
- If you visit a web site or receive an e-mail that makes you feel uncomfortable, tell your parent or whoever looks after you
- Don't tell other people your Internet passwords
- Never agree to meet up with someone you have met on the Internet
- Try to avoid staring at the screen for too long without a break

Some interesting web sites for you to try:

- www.kidscom.com - fun and games
- www.bbc.co.uk/cbeebies - games and fun things to do
- http://kids.yahoo.com - Yahoo! kids search engine
- www.bbc.co.uk/schools - BBC Schools
- www.channel4.com/learning - homework help
Advice for Parents

There are many useful sites with advice about safety for children online including:

- [www.kidsmart.org.uk](http://www.kidsmart.org.uk)
- [www.nspcc.org.uk](http://www.nspcc.org.uk)
- [www.nch.org.uk](http://www.nch.org.uk)
- [www.safekids.com](http://www.safekids.com)
- [www.protectkids.org](http://www.protectkids.org)

Restricting Internet use to a PC in a family room is one way you can keep an eye on your child's browsing activities. You will be able to take an occasional glance to make sure they are safe, without them feeling like you are watching their every move.

Letting them know your concerns and educating them about the dangers of the Internet will help them understand you are not trying to stop them enjoying the Web, just making sure that they have a safe experience.

There are also various software packages available that can help you monitor your child's browsing when you are not in the room.

These programs can record browser web addresses, e-mails, and chat software, and can also filter and block certain web sites and even record what has been typed on the keyboard:

- [www.softwarexpress.com](http://www.softwarexpress.com) - The Internet Babysitter
- [www.cyberpatrol.com](http://www.cyberpatrol.com) - CyberPatrol
- [www.riasc.net/plg.aspx](http://www.riasc.net/plg.aspx) - Parental Lock Guard
- [www.contentwatch.com](http://www.contentwatch.com) - ContentProtect
- [www.naomifilter.org](http://www.naomifilter.org) - Naomi
- [www.surfsafe.co.uk](http://www.surfsafe.co.uk) - SurfSafe

If your kids use Google to search for things, in the Preferences next to the search box there are options under SafeSearch Filtering to block explicit images or text.

In Windows it is possible to create a separate user account that can be restricted so that the user cannot install harmful software, remove crucial files or change Windows settings.

Create a new user account for your child by clicking on the Start menu then Control Panel and clicking on User Accounts. Click Create a new account, choose a name and choose a Limited account then click Create Account.

You may also wish to put a password on your own Administrator account so that your child cannot use it to install or remove programs.

If your child regularly uses chatrooms, instant messaging or social networking sites, there is an electronic identity card service they can use to verify who they are talking to: [Net-ID-me](http://www.net-id-me.com)
Jargon

This section features explanations of common computer and Internet terms.

Adware
Advertising program often installed along with other programs

Attachment
A file attached to an e-mail message for sending between computers

Blog
Web log. Personal web page where the author can post their views and experiences and receive comments.

BMP
Bitmap. The most common graphics file type for Windows PCs

Bookmarks
List of your favourite web sites

Browser
Software that displays web pages such as Internet Explorer and Firefox

Compression
A method of reducing the storage space a file takes up. Files must be decompressed to be used again

Crash
Occurs when a program causes your computer to stop responding

Demo
Free demonstration version of software that allows you to try before you buy

Directory
An index of web site links arranged in categories

Disk Space
The size of the area on the hard disk where files can be stored

Domain name
URL or Address of a web site on the Internet

Download
Transfer a file from another computer to your own

Driver
Software required for Windows to use a piece of hardware such as a graphics card

E-mail
Electronic mail passed between computers

Favorites
List of your favourite web sites

Firewall
Program or device that blocks or allows Internet access to a network or a PC

Flash
Software to create and play web site animations

Font
Text of a particular size and style

Freeware
Software that is free to download and use for as long as you like
Hardware
Physical parts of a computer system such as the hard disk, keyboard and printer

HTML
HyperText Markup Language. The code that makes up a web page

Home Page
The main page of a web site, often a welcome page

Hyperlink
A text or graphic you click on to go to another page or a different web site

Internet
A collection of inter-connected computer networks

Install
To load and copy program files onto a computer

JPG / JPEG
Compressed graphics file for sending across the Internet

Link
A text or graphic you click on to go to another page or a different web site

Malware
Malicious software such as virus or spyware programs

Modem
Device that links a computer to the Internet through a telephone line

MP3
Compressed audio file to save disk space and for transfer across the Internet

Online
Connected to the Internet

Phishing
Fraudulent e-mails trying to trick you into giving out personal details

Plug-in
Extra programs that can be installed into larger programs to handle special tasks, such as playing certain types of movie files in a browser

Podcast
Internet audio broadcast that can be played back on PCs or MP3 players such as the iPod.

Pop-Up
Small window that appears on a web page, often used for advertisements.

Program
A set of instructions to make a computer carry out a task

Rootkit
Software that hides system files and can allow attackers to access your computer undetected

Router
Device used in home Internet networks to send data from the web to specific computers

RSS
Really Simple Syndication - a system to feed you news stories from web sites

Search Engine
Tool that searches the Web for keywords and provides relevant links

Server
A computer that holds Internet data such as web site files and can send it to another computer when requested
Shareware
Software that is free to download but you pay a fee if you want to continue using it after the trial period

Shortcut
A link you can click to go straight to a particular program or web page

Software
A program or a set of instructions to make a computer carry out a task

Spam
Junk mail messages to e-mail addresses

Spyware
Software that tracks your movements on the Web for advertising purposes without your knowledge

Stream
Start playing music or video as soon as it begins downloading

Surfing
Moving from one web page to another

Trial
Software that allows you to try before you buy

Trojan
Malicious virus program disguised as useful software

Uninstall
Remove program files from a computer

Upload
Send a file from your computer to an online destination

URL
Uniform Resource Locator. The address of a web site on the World Wide Web

Virus
Destructive program that infects and damages computer files

VoIP
Voice over Internet Protocol - voice conversations across the Internet

WAV
The standard audio file type for Windows PCs

Web Page
Individual page on a web site

Web Site
A collection of connected web pages located at a particular domain name

Wiki
Web site that can be edited by users to add information

Windows
Microsoft operating system installed on most PCs

World Wide Web (WWW)
Information space on the Internet stored on servers across the world containing documents connected together through hyperlinks

Worm
Malicious code that uses an infected PC to spread itself to others

Zip
Compressed file format to reduce disk space needed by a file and to transfer it between computers more quickly
Common Filetypes

Below is a list of common file types with a brief description and examples of programs that can open these files.

If a file does not appear to have an filetype extension, open the folder it is stored in and click on Tools from the menu, then Folder Options. Click on the View tab and un-tick Hide extensions for known file types.

- .avi - video file. Open with Windows Media Player
- .bmp - image file. Open with Paint
- .cfg - configuration file.
- .dat - data file.
- .doc - document file. Open with Word
- .exe - program file. Double-click to run
- .gif - image file. Open with Paint
- .htm - web document. Open with Internet Explorer
- .html - web document. Open with Internet Explorer
- .ini – text configuration file. Open with Notepad
- .jpeg/jpg - image file. Open with Paint
- .mov - movie file. Open with Quicktime
- .mpeg/mpg - video file. Open with QuickTime
- .mp3 - audio file. Open with Windows Media Player
- .pdf - secure document file. Open with Adobe Reader
- .pps - slideshow presentation. Open with PowerPoint
- .ppt – presentation file. Open with PowerPoint
- .sys - system file.
- .txt - text file. Open with Notepad
- .wav - audio file. Open with Windows Media Player
- .xls - spreadsheet file. Open with Excel
- .zip - compressed file. Open with WinZip
Keyboard Shortcuts

This section features a list of key combinations that can be used to perform special functions.

- *Windows key* - access Start menu
- *Windows key + Pause* - open System Properties
- *Windows key + D* - minimise/restore windows
- *Windows key + F* - open Search window
- *Windows key + F1* - open Help and Support Center
- *Windows key + E* - open Windows Explorer window
- *Windows key + M* - minimise all windows
- *Windows key + TAB* - move through open windows on Taskbar
- *Windows key + SHIFT + M* - restore all windows
- *Hold CTRL while dragging* - make a copy of selected item
- *Hold CTRL + SHIFT while dragging* - make a shortcut to selected item
- *CTRL + ESC* - open Start menu
- *CTRL + C* - Copy
- *CTRL + X* - Cut
- *CTRL + V* - Paste
- *CTRL + A* - Select All
- *CTRL + Z* - Undo
- *CTRL + B* - Bold highlighted text
- *CTRL + U* - Underline highlighted text
- *CTRL + I* - Italicise highlighted text
- *CTRL + Plus key* - increase browser text size
- *CTRL + Minus key* - decrease browser text size
- *CTRL + ALT + DELETE* - open Task Manager
- *ALT + underlined letters in menus* - open menu item
- *ALT + ENTER* - show Properties of selected object
- *ALT + F4* - close current window or program
- *CTRL + F4* - close window within program
- *ALT + TAB* - switch between open windows or programs
- *TAB* - move forwards through control items or links in current window
- *SHIFT + TAB* - move backwards through control items or links
- *ENTER* - click selected control item or link
- *BACKSPACE* - move up one folder level
- *HOME* - go to start of current line or web page
- *END* - go to end of current line or web page
- *CTRL + END* - go to end of current document
- *PAGE UP* - move up through current document or web page
- *PAGE DOWN* - move down through current document or web page
- *PRINT SCREEN* - take snapshot image of current screen
- *ALT + PRINT SCREEN* - take snapshot image of current window
- *F2* - rename selected item
- *F5* - refresh current window or web page
- *F6* - move through window panes
# Version History

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.00</td>
<td>December 2006</td>
<td>First version</td>
</tr>
</tbody>
</table>